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Document Conventions 

The following icons are used in this manual to distinguish elements of text. 

 
Contains additional information for the reader that is not safety 
related. 

 

 
Describes a situation or practice that if ignored, will result in 
equipment damage or loss of data. 

 

 
Describes an unsafe condition or practice that, if not 
corrected, will result in personal injury, possibly death. 

 

The MACS II is designed for conformance with relevant standards and practices as 
published by API Subcommittee 10 on Well Cements. 
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1.1. Multiple Analysis Cement System II 
The Multiple Analysis Cement System (MACS) II is a device that performs static gel 
strength tests on cement slurry samples. Following are several pictures of the unit. 

 
Figure 1-1 MACS II Front View (Shown with Customer Laptop) 
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Figure 1-2 MACS II with Door Open 
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Figure 1-3 Turn Table Assembly And Pressure Cell 

The MACS II conducts these tests under simulated down-hole pressure and 
temperature conditions to determine the following characteristics of cement: 

 Transition time. 

In these tests, the MACS II accepts a sample of cement slurry and applies a 
controlled set of temperature, agitation, and pressure parameters that simulate the 
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down-hole conditions of a well. During testing, it monitors, controls, and records 
these parameters to form a data set. This data can then be analyzed to assist in 
predicting the performance of cement slurry in a well.  

If a situation exists that a well presents particular problems or special conditions of 
temperature and/or pressure, the MACS II can assist to minimize possible problems 
by providing a safe and controlled environment in which to test different cement 
slurries for the drilling process. 

The maximum temperature for the MACS II analyzer is 
600˚F. The maximum pressure for the MACS II analyzer is 
30,000 PSI. 

1.1.1. Transition Time 
Transition time is determined by the measuring the static gel strength of cement 
slurry. Transition time is the elapsed time from the occurrence of static gel strength 
of 100 lb/100 ft2 to the occurrence of static get strength of 500 lb/100ft2. 

This test determines the gel strength development of cement slurry after it has been 
placed in a well and allowed to remain static. Rapid static gel development (short 
transition time) indicates good gas migration control. 

1.2. Special Considerations 
The MACS II is a unique device that performs analysis for cement slurry. In order to 
perform reliable tests, the unit generates significant temperatures and pressures. 
Care and caution should be exercised to minimize the potential for personal injury 
and/or damage to facilities. 

 The mag drive, pressure inlet port, pressure control port, manual and dump 
valve ports are all intricately designed so that routine connections and 
disassembly are not necessary on the chamber. This helps prevent thread 
wear in the chamber and cap. 

 The manual relief valve located in one of the three ports located in the 
chamber bottom is designed for relieving pressure from the chamber when all 
other means have failed. Do not use this to routinely relieve pressure. Do not 
use this manual value until the slurry temperature is below 140˚F. . 

 When a test is to be run at a higher temperature, use an O-ring rated for 
higher temperature (P/N 101710014) on the chamber lid. On tests less than 
20000 PSI and 250˚F, use the standard O-ring (P/N 206712). 
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Be alert to symptoms indicating the pressure does not 
reduce. This may be an indication of a blocked control 
outlet line or filter. The pressure control is a multi tiered 
design with separate ports being used for pressure up, 
absolute overpressure safety, manual release, controlled 
dump and automatic release. 

 Do not use PVC or similar materials for drain lines. The hot water and/or 
steam can cause melting or other significant damage. 

 Do not pour the slurry down a drain because it can easily clog pipes. 

 If the slurry is hazardous to the environment, use proper disposal 
procedures. 
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2.1. Machine hazard 
MACS II has multiple subsystems that if not understood and operated correctly can 
be hazardous to the operator which can cause serious harm including death. Faulty 
procedures or inadequate precautions can also damage the machine rendering it 
inoperable. 

2.1.1. Pressure 
The Macs II has pressurized air and water lines that present a hazard if not 
depressurized before maintenance or disassembly. 

Shop air is needed at the unit to operate the hydraulic pump, the pressure control 
system, the cell lid, the cell body and drawer assemblies. This air is pressured to 100 
psi. Before working on any of these devices or connected air lines, shut off the shop 
air to the machine. The air lines are plastic and are connected by quick-connect type 
fittings. 

Domestic water is used by the machine for cell cooling and as a pressurizing fluid. 
Shut off the domestic water before working on either of these systems. In some labs, 
a separate chilled water system is used for cooling below ambient. This system may 
also be under pressure so it should be turned off or disconnected. The drain line has 
no pressure on it; it does not need to be disconnected. 

The high pressure lines present the greatest hazard as they can hold up to 30,000 
PSI water. These lines are ¼ inch OD stainless steel. Operators must ensure that the 
pressure in these lines has been bled down to zero before attempting to disassemble 
any lines or access the high pressure filter. Dump any pressure using the manual 
pressure down system provided in software and verify this by opening the manual 
dump valve located on the right side of the turn table assembly. Confirm that all 
pressure in the system has been relieved using the pressure gauge located at front-
top of the Macs II machine. 

2.1.2. Temperature 
The pressure chamber has an electric heating jacket that can heat the cement slurry 
to 600°F (315°C). The metal jacket and lid itself will be even hotter than that. Before 
opening the pressure chamber or performing any work on the heating jacket, use the 
cooling system to lower the temperature below120°F (49°C). Use the temperature 
display in the software to gauge the temperature.  

The coolant return line can be very hot [212°F (100°C)] at the beginning of a cool 
down cycle. Take precautions to not touch the coolant return line. Connect the 
coolant return line to drain in a manner which will not cause a burn hazard. 

2.1.3. Electrical 
The power source for the Macs II is 230 Volts. Disconnect the power from the plug 
before attempting any electrical or mechanical maintenance.  
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There are still hot electrical terminals inside the panel when the power switch is 
turned off It is always safe to physically disconnect the machine from the Power 
source rather than using Power On/Off Switch to isolate power. 

Refer to the electrical schematic before performing any maintenance or 
troubleshooting. 

2.1.4. Pinch Points 
The pressure cell, lid and drawer are all controlled by air and operate slowly. 
However, the operator should not interfere, place tools or body parts in paths of 
these controlled motion.  

The cell assembly is very heavy and can cause severe injury if an obstruction is 
placed in its path. When Cell motion is initiated keep hands away and well clear of 
the cell assembly. 

The cell lid lifts up and facilitates easy removal of O-ring. While operating Cell Lid 
make sure to stand clear and keep an unobstructed path for the cell lid. 

The cell drawer can also be controlled in and out of the Macs II. Ensure that the front 
doors are open and that nothing blocks the drawer when the process is initiated. Do 
not stand in front of this area while Drawer motion is initiated 

2.2. Ergonomic Considerations 
The Macs II is a large, heavy machine that must be handled carefully when moving 
during installation or maintenance. The casters allow the machine to be rolled easily 
in the lab, operators should only roll the machine slowly and should watch for debris 
on the floor. If the machine must go on an incline or decline, more than one person 
should help guide it. 

The pressure chamber has a heavy lid that that is slowly raised and lowered 
automatically with air. The cell body as well as the cell drawer is also slowly 
controlled with air. There are no heavy components that the operator must move 
other than a sample loaded slurry cup at less than 10 lbs.  

2.3. Environmental Considerations 
This machine tests cement slurries with additives, using water as a pressurizing fluid. 
The operator must be aware of proper handling and disposal practices for these 
materials. 
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3.1. MACS II Installation Preparation 
Qualified Fann staff shall be needed to professionally commission the MACS II 
system. Before and after commissioning; there are facilities, computing, and 
knowledge prerequisites that must be meet for the proper functioning of the MACS II 
device. In addition, certain materials and tools are necessary for the mechanical 
installation and maintenance that are not supplied with the MACS II system. 

There are certain facility requirements to consider in designating a location for the 
MACS II system. It is necessary to provide a facility space at which to locate and 
operate the MACS II system that is properly designed, equipped, and HSE assessed 
for SGS testing. 

 Physical Requirements 

 Operational Considerations 

 Computer Specifications 

3.2. Physical Requirements 
The MACS II instrument is approximately 146 ft3 (4.15 m3) in size. It occupies an 
area of 52.0 in. D x 58.0 in. W (132 x 48cm) or 20.0 ft2 (2.00 m2) of floor space.  

For safe access, installation and continued reliable operation, Fann recommends 12 
in. clearance in the back and on the side of the unit. In the front at least 18 in. of 
clearance is needed. Minimum space dimension requirements are as follows. 

Description Measurement 

Width (front and back) 35.0 in (89 cm) 

Depth (sides) 28.0 in (72 cm) 

Height (floor-to-roof) 80.00 in (203 cm) 

Total floor space 52.0 in. D x 58.0 in.  W (132 x 148 cm) 

Total floor area 20.0 ft2 (2.00 m2) 

Weight 750 Lbs (340 Kgs) 

Refer to Section 9 Accessories and Schematics for more information. 

3.3. Operational Considerations 
The operation of the MACS II requires electric connection and supply/drainage of 
compressed air, water, and/or coolant. These services need to be available at the 
location where the MACS II system resides, as per the following minimum 
specifications. 
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Description Measurement 

Electric Single-phase 230 V, 30 Amps, 50/60 Hz AC power supply 

Compressed air 100 PSI (0.79 MPa), filtered, 50 micron 

Water 30 PSI (0.31 MPa), filtered, 250 micron/60 mesh 

Water drain 212°F (100°C) 

Coolant In & Out 
differential 5PSI (0.14 MPa) 

The machine comes equipped with Power Cord which has a specific 250V/30A power 
plug (Fann P/N 101648380, Hubbell P/N HBL2621) Please ensure you have a suitable 
electrical outlet that mates with the supplied Power cord. 

3.4. Computer Specifications 
The MACS II system includes state-of-the-art software that runs on a Microsoft 
Windows-based computer connected via USB. The software can also receive updates 
via the Internet. Provided with the MACS II is a DVD-ROM containing the software to 
install on the computer. 

Following are the minimum computer system requirements for the MACS II system. 

Component Specification 

Type of computer Laptop or small form factor PC 

Operating system Microsoft Windows® XP or Windows® 7 

Processor Single or dual core, 1.6 MHz clock speed, Intel or AMD 

Memory 2 GB of RAM 

Graphics WSXGA (1200x800) resolution or higher 

Hard drive 5 GB available 

Optical drive DVD 

Input devices Keyboard and mouse 

Internet access 1.5 Mbits/s data transmission rate (Tier 1 broadband) 
 

Fann does not include a computer with the MACS II system 
for running the software provided on the DVD-ROM. The 
computer is the sole responsibility of the user and must be 
purchased separately. 
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4.1. Pre-Installation Considerations 
Before installing the MACS II, the operator has these knowledge prerequisites: 

 Mechanical/Pneumatic/Hydraulic familiarity. 

 Basic Microsoft Windows familiarity 

 Knowledge of Gel Strength test procedures 

The physical installation of the equipment requires the following materials and tools: 

 Tubing for water in/out and hot water discharge 

 Tubing for air in (100 PSI minimum) 

 External chiller (if testing below ambient temperature) 

 Connectors and fittings (pneumatic & hydraulic) 

 Adjustable wrenches and/or pliers 

The installation consists of two separate components: 

 Hardware (Mechanical) Installation 

 Software Installation 

4.2. Hardware (Mechanical) Installation 
This section for the hardware installation assumes the site for the equipment has 
been prepared and contains all of the requisite electrical and plumbing components 
to install the equipment. 

4.2.1. Water, Air, and Coolant Connections 
In order to function, it is necessary to connect the MACS II to water, compressed air, 
and coolant sources. Ports for connecting these services are on the back of the unit. 

Component Connect to… 

Air In (100 PSI minimum) Compressed air supply 

Water In (30-60 PSI) City water supply 

Water Out (Open, No restrictions) City water supply 

Hot Out (Open, No restrictions) Drain 

Chill In Coolant supply 

Chill Out Coolant supply 

This list is the correct order of the connectors on the back of the unit. Figure 4-1 
shows the type and arrangement of hydraulic and pneumatic ports in the back of the 
MACS II unit. Use only flexible hose lines for connecting the services to the ports. 
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The available ports are 0.25 inch (0.635 cm) female national pipe thread labeled as 
follows: 

Always use separate hoses for connecting “Water Out” and 
“Hot Out” ports to drain. Never use a single hose with a T-
connector for these two outlets. 

 
Figure 4-1 MACS II Hydraulic and Pneumatic Ports 

Depending on the cooling fluid and ambient conditions at the 
site, it is possible for drained coolant to be classified as a 
hazardous waste. This is because of high pH or high lead 
content. Therefore, disposal of coolant may require special 
procedures and compliance with local, state, or federal 
environmental regulations. 
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4.2.2. Electric Power Connection 
The MACS II is supplied with a 6 foot (1.83 m), 50 amp power cord to connect to a 
current protected electrical outlet. Because of the variety of electrical outlets 
throughout the world, a plug is not already attached. Wire the MACS II directly into 
an electrical disconnect (circuit breaker) or attach an appropriate plug and connect 
the MACS II into an electrical outlet with fault interrupt protection. 

There is also a 110 volt outlet on the back of the unit for powering the computer that 
runs the MACS II software. This outlet should be used with a laptop computer only. A 
desktop computer initiates a shutdown in case of power glitch losing the test. 

4.2.3. Power Up MACS II Unit 
Ensure that the circuit breaker or circuit interrupt reset is engaged before powering 
on the MACS II unit. Use the power switch located at the back of the unit to switch 
“on” the MACS II unit.  

4.2.4. Initial Verification of Alignment 
The following methods are available to adjust the MACS II to achieve the optimal 
alignment of the cell bottom to the cell top. 

 X Direction (left-right). Use the pillow block fixtures to align the cell top with 
the cell bottom. 

 
Figure 4-2 X Direction Adjustment 
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 Y Direction (up-down). Use the bolting mechanism on the actuator to raise or 
lower the cell bottom. 

 
Figure 4-3 Y Direction Adjustment 

 Z Direction (in-out). Use the drawer cylinder and drawer stop mechanisms to 
perform this adjustment. 

 
Figure 4-4 Z Direction Adjustment 
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 R Direction (rotation). Use the locking bolt on the rotary actuator to adjust the 
rotation so that the cell tabs are aligned to mate. 

 
Figure 4-5 R Direction Adjustment 

There are several switches that limit the motion of the unit. These include a linear 
actuator which moves the cell up/down, a rotary actuator that controls cell rotation, 
and actuating cylinders that control drawer in/out and top plate up/down. 

 
Figure 4-6 MACS II Limit Switches 
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Ensure these limit switches are adjusted to stop the rotation when the end limit is 
attained. 

Use the following checklist to verify proper motion and alignment of the various MCS 
components. Perform the alignments using the software or by manually actuating 
the respective solenoids. 

 Verify that the cell top and bottom align and mate properly without 
interference. 

 Verify that the drawer moves in and out freely. 

 With the drawer at out position, verify that the slurry cup can be easily loaded 
into the cell. 

 Verify that the top plate assembly raises and lowers properly. 

 Verify that the cell can rise and lower smoothly. If necessary, use 0.020-in 
and 0.060-in filler gauges to adjust the height. Note that the 0.020-in gauge 
should move freely between the cell top and cell bottom when the cell is 
raised. A 0.060-in gauge should not move or be hard to put between the two 
assemblies. 

4.2.5. Water Test 
A heated and pressurized water test can detect leaks and other problems. Perform 
the following steps: 

1. Fill the slurry cup with water. 

2. Apply heat and pressure to the water to a maximum of 250°F (121.1°C) and 
20,000 PSI (137.9 MPa; 1,406.5 Kg/cm; 1,379.3 Bar). 

3. Inspect for any leaks or other obvious problems. 

4. Fix minor problems by tightening or reconnecting. 

5. Document any problems found and contact Fann Customer Support. 

4.3. Software Installation 
Fann provides the following software to operate and configure the MACS II on a 
DVD-ROM included with the system: 

 MACS II SGS Software Components 

 Edgeport USB Drivers for Microsoft Windows 

Install the software on the dedicated computer associated with the unit. Verify that 
this computer meets or exceeds the requirements. Refer to Section 3.4 Computer 
Specifications for computer hardware specifications to run the MACS II SGS 
software. 
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If you have experience installing software on Microsoft Windows operating systems, 
the instructions in Section 4.3.1 Software Quick Install may suffice. If a more 
detailed description is necessary, refer to Section 4.3.2 MACS II SGS Software 
Installation. 

 Software Quick Install 

 MACS II SGS Software Installation 

 USB Connection Configuration 

 Software Updates 

4.3.1. Software Quick Install 
Perform the following procedure for a quick install of the MACS II software: 

1. Run the Setup program on the DVD to launch the MACS II software installation 
wizard. 

2. Read the dialogs and follow the on-screen prompts. 

3. When prompted, shutdown the computer. 

4. With the computer turned “off”, connect the two provided USB cables from the 
MACS II device to the computer. 

5. Power “on” the computer and it should find the new hardware and install the 
USB drivers. 

6. If the computer prompts for a search for compatible drivers, browse to the 
Edgeport folder on the hard drive root (typically C:\Edgeport). 

By default, the setup program copies the MACS II USB 
drivers from the DVD-ROM to the Edgeport folder on the 
hard drive root during installation. Depending on the 
computer’s operating system configuration, the Found 
New Hardware wizard may or may not install the USB 
drivers, prompting a manual search for the drivers. For 
details, refer to Section 4.3.3. USB Connection. 

4.3.2. MACS II SGS Software Installation 
Perform the following procedure to install the MACS II software: 

1. Insert the supplied software installation DVD-ROM into the DVD drive of the 
computer. If auto run is enabled, the software installation wizard starts 
automatically. Alternatively, open Windows Explorer and navigate to the 
DVD drive root on the computer. Double click Setup.exe. 
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2. Once the installation wizard loads, read the start screen. Click Next. 

Click Back to return to a previous screen in the wizard. 
 
It is possible to exit the wizard at any time during the 
install. Click Cancel to exit the installation wizard. 
 
Rerun the installation wizard from the start when you wish 
to complete the software installation.  

3. Read the product information before proceeding. Optionally, click Save File to 
save this information to the computer as a text file. Click Next. 

4. Review the installer default locations. Click Next. For purposes of automatic 
online updates, Fann recommends to not change these locations. 

5. Read the National Instruments software license agreement. Click Next. If you do 
not accept the agreement, the wizard terminates. 

6. Read the Interchangeable Virtual Instruments, Inc. software license agreement. 
Click Next. If you do not accept the agreement, the wizard terminates. 

7. Review the list of software to be added to the computer. Optionally, click Save 
File to save this information to the computer as a text file. Click Next to start the 
installation process. 

8. During the installation, the progress bars indicate the status of the progress in. To 
stop the install, click Cancel at any time during the process. Rerun the 
installation wizard from the start when you wish to complete the software 
installation. 

9. The installation wizard prompts upon completion of the installation. Click Finish. 

10.Once the wizard exits, a message box displays prompting a restart of the 
computer. Click Shut Down. This is necessary for the next step in the installation 
process. 

 

The computer must be powered “off” before connecting it 
for the first time to the MACS II device via Universal Serial 
Bus (USB). 

4.3.3. USB Connection Configuration 
The MACS II system uses Universal Serial Bus (USB) plug and play interface 
technology to communicate with the MACS II SGS software installed on a Microsoft 
Windows-based computer. To connect the MACS II device for the first time to the 
computer with the SGS software, setup the USB connection as follows: 

1. Ensure that both the MACS II device and the computer are powered “off”. 
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2. Plug the “B” type male connector of one of the two supplied USB cables to one 
of the USB Standard “B” female plugs located on the back of the MACS II. Plug 
the other USB cable to the remaining female plug on the MACS II. 

  
“B” Type Connector 

3. Plug the other end of each of the two supplied USB cables, which is an “A” 
type male connector, to the USB ports of the dedicated computer. 

  
“A” Type Connector 

During boot up, the Windows operating system on the 
computer should detect the USB connection and install the 
necessary drivers. In this case, the installation is complete 
and it is not necessary to perform the remaining steps. If 
it cannot find the drivers however, Windows launches the 
Found New Hardware wizard. Then it is necessary to 
proceed with the remaining steps below.  

4. Read the welcome screen. Select No, not this time to respond to the 
question: Can Windows connect to Windows Update to search for software? 
Click Next. 

5. Select Install from a list or specific location (Advanced). Click Next. 

MACS II 

Computer 
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6. Select Search for the best driver in these locations. Select the Include 
this location in the search check box. Click Browse to navigate to the path 
C:\Edgeport which is the folder where the USB driver files were copied from 
the DVD during the MACS II SGS software installation. Click Next. 

 
Figure 4-7 Found New Hardware Wizard 

7. Once the USB drivers have been installed, the wizard prompts that it has 
finished installing the Edgeport software. Click Finish. 
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If the error dialog box displays, the USB connection may have failed to set up 
properly. Read this screen and click Automatic to proceed with troubleshooting the 
problem. Alternatively, refer to the instructions from the beginning in Section 4.3.3. 
USB Connection. 

 
Figure 4-8 Unable to Import Configuration Settings Dialog Box 

The MACS II system is ready to perform the post-installation verification procedure. 
Refer to Section 4.4 Post-Installation Verifications for this information. 
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4.3.4. Software Updates 
The MACS II system is set up to receive automatic software updates remotely over 
the Internet. When connected to the Internet, click Help > Check for Updates… 
and a dialog box displays. 

 
Figure 4-9 Software Updates Dialog Box 

Click Start to check for updates. If the current version is the latest, a message 
displays to confirm that status. If a later version is available, it notifies of this event. 
Click Update to download the latest version of the software to the computer. 

Do not perform this task when running a test. When the 
software updates, it closes the program and loses all data. 
It is necessary to restart the program to resume testing. 

4.4. Post-Installation Verifications 
Before calibrating, configuring, and running tests with the MACS II system, Fann 
strongly recommends the following post-installation verifications. 

Visually inspect the MACS II system for loose connections and fittings or any other 
obvious problems. Using the appropriate tools, tighten anything that is loose. Be 
careful not to over-tighten the connections. Verify that none of the hoses leak or that 
there are any faulty connections. Refer to Section 5 MACS II Software to understand 
how the MACS II Software operate 

Verify the following subsystems using MACS II software. 

1. Verify that all valves operate by using the Operate Valves screen. 
2. Verify that the motor locks and rotates in CW and CCW directions. 
3. Verify that the unit pressures up to 2000 PSI. 
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4. Verify that the unit heats up when temperature setpoint is set 20 degrees 
above ambient 
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5.1. Software Basics 
Fann MACS II software is intuitive to use. If the user has had experience using 
Microsoft Windows and has basic knowledge about SGS testing, there should be no 
difficulty understanding the information in this section or using the software. 

Double click the MACS II desktop icon. Alternatively from the Windows task bar, 
select Start > All Programs > Fann > MACS SGS. The software loads. A message 
dialog box displays notifying of this activity. Upon loading, the Calibration and 
Operate menus are unavailable (gray) until you connect to the MACS II unit. 

5.2. Interface Elements 
Figure 5-1 shows the desktop for the MACS II program. Following are descriptions of 
each of the elements of this interface. 

 
Figure 5-1 MACS II SGS Software Main Screen 

The primary components of the desktop include: 

 Menu Bar 
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 Variable Indicators 

 Status Indicator 

 Start/Stop Test button 

 Results Graph 

5.2.1. Menu Bar 
The Menu Bar, at the top of the desktop, provides top level control for the program. 
The available options include: 

 File 

 Edit 

 Calibration 

 Operate 

 Help 

Refer to Section 5.3 File Menu for more information on these options. 

5.2.2. Variable Indicators 
The variable indicators located across the top of the desktop, display the current 
values of the measured parameters. 

 Elapsed Time – Elapsed time since start of test. 
Display format is HH:MM:SS. 

 

 Temp.Heater – Current heater temperature.  
Unit of measure is degrees Fahrenheit. 

 

 Temp.Sample – Current sample temperature.  
Unit of measure is degrees Fahrenheit. 

 

 Torque (oz.in.) – Current torque value.  
Unit of measure is ounce-inches. 

 

 Pressure – Current pressure value inside cell.  
Unit of measure is PSI. 
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 SGS (lb/100 Sq. Ft.) – Current static gel strength 
(SGS) value as computed from torque value.  
Unit of measure is lbs/100 ft2.  

5.2.3. Status Indicator 
The Status Indicator, located right of the variable indicators, displays the mode of 
the MACS II device, as follows: 

 Idle – The software is disconnected from the MACS II unit. 

 Connected – The software is communicating with the MACS II unit and is 
updating values shown in the indicators. 

 Running – A test has been started and the software is updating the 
indicators, the graph, and logging data. 

 Safe Mode – The Emergency Safety Switch has been activated and the 
system is inoperable. 

5.2.4. Start/Stop Test Button 
Click this button to start or stop a test. Depending on the status, the button changes 
color. 

 Start Test – When the status is in Connected mode, the button displays 
Start and its color is a shade of blue. Click to launch the Start Test wizard. 

 Stop Test – When in Running mode, the button displays Stop and its color is 
a shade of green. Click to abort the test. 

If stopping a test, it is necessary to restart from the 
beginning. Refer to Section 5.8 Start Test Wizard for more 
information on starting, running, and stopping tests. 
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5.2.5. Results Graph 
The Results Graph is the main component and dominant portion of the desktop. It is 
the large portion of the screen below the variable indicators and status indicator. 
During a test, the XY Graph displays the temperature, pressure, SGS, and 
consistency that compose the test results. 

 
Figure 5-2 XY Graph 

With the cursor inside the graph, right click to display a context menu with the 
following options: 

 Show Bc (factory use only) 

 Show Torque 

 Show Cursor 

 Hide Cursor 

 AutoScale X 

 AutoScale Y 
AutoScale Y becomes available only when the mouse hovers over a particular Y-
scale. Autoscaling for that particular Y-scale then can be turned “on” or “off”. 
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5.3. File Menu 
The File Menu provides access to the following commands: 

 Connect 

 Disconnect 

 Save Data 

 Exit 
Depending on the current status of the software connection with the MACS II unit, 
some of the file menu commands are unavailable (gray). When the status indicator 
displays Idle all other commands except Connect & Exit are unavailable. 

5.3.1. Connect Command 
The Connect command establishes communication with the MACS II unit. 

1. Before connecting, note that the status indicator displays Idle and that all 
measurements are zero. 

2. From the File menu, choose Connect. 

3. It may take a couple of minutes to establish the communication link. A "Please 
Wait…" message displays to notify of this status. 

4. The software first automatically adjusts the drive mechanisms. A message 
displays to notify of this status. 

5. The software is now connected to the MACS II unit. The status indicator shows 
as Connected. 

6. The Variable indicators start displaying current measured values. 

5.3.2. Disconnect Command 
The Disconnect command terminates communication with the MACS II unit. 

1. From the File menu, choose Disconnect. 

2. The software is now disconnected from MACS II unit. The status indicator 
displays Idle. 

5.3.3. Save Data Command 
The system automatically saves test data to the designated location in Step One of 
the Start Test wizard. The Save Data command provides a method to save test data 
to a different location. Both methods of saving data, writes the data with the .tdms 
extension. Note that a test cannot be in progress when executing a save command. 
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1. From the File menu, click Save. 

2. The software writes the data to the designated drive and file. 

5.3.4. Exit 
The Exit command closes and exits the program. 

1. From the file menu, choose Exit. 

2. The software terminates. 

5.4. Edit Menu 
The Edit Menu controls the settings and configuration of the unit. This menu 
provides access to the following commands: 

 Machine Settings 

 Profile Editor 

In normal operations, it should be unnecessary to change 
most of the Machine Settings values and settings in these 
screens. Only advanced or experienced users should 
change these values significantly.  

5.4.1. Machine Settings 
The Machine Settings option under the Edit menu is a tabbed screen with several 
options. When first initialized, the General tab is the default display. The tabs on 
this screen include: 

 General 

 Test Header 

 Motion 

 Constants 

 PID 
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5.4.1.1. General Tab 
Click Edit > Machine Settings to display the Edit Machine Settings General 
screen. The first display in this group is the General tab. 

 
Figure 5-3 General Tab Screen 

Below is the explanation of the individual items on this screen 

1. Machine Units – This is where units of measurement for Temperature and 
Pressure can be set. Currently, this setting has no functionality as the units 
are fixed to degF and PSI for temperature and pressure respectively. 

2. Safety – This section sets up interlocks within the software for safe operation. 

a. Min Pressure – This tells the machine to not allow the pressure to drop 
below the “Min Pressure” value if current temperature is above the “Min 
Temp.” value. 

b. Min Temp. – This determines if pressure can be dropped below the 
“Min Pressure” value. If current temperature exceeds the “min Temp.” 
value then pressure cannot be reduced below the safety value. 

3. Pressure – These setting determines the tolerance to which the pressure 
seeks to adjust for any given setpoint. 

a. Normal DeadBand – If the measured pressure when compared to Set 
Pressure is within the tolerance as specified by this value, then all 
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pressure control activity is suspended. Pressure control is resumed once 
the measured pressure drifts outside of this tolerance value. The 
nominal tolerance for the machine is 200 PSI. 

b. SGS DeadBand – This works in the same manner as “Normal 
DeadBand” except that it is effective only during the Static or Gel phase 
of the test. Normally during the Static or Gel phase, any pumping of 
pressure disturbs the gel formation of the cement. By selecting a higher 
value of pressure tolerance such pumping can be prevented. The 
disadvantage is that pressure may drift from setpoint by the tolerance 
specified. Typically this value is set to 1500 PSI. 

4. Cooling – The cooling action of the machine is controlled by settings in this 
group. 

a. Auto Cool After Test – If this check box is chosen the machine begins 
a cooling cycle after test is over. 

b. AirWater Switch – This determines the cooling medium used for 
cooling. If the heater temperature is above this value, then air is used 
as the cooling medium. If the heater temperature is below this value 
then water is used as the cooling medium. 

Be careful when selecting the AirWater Switch 
temperature. If temperature is above 212°F, then the unit 
uses water to cool a heater above the boiling point of water 
and superheated steam will come out of the Hot Out line at 
the back of the machine. 

c. Cooling Off – This determines at what sample temperature, cooling 
automatically turns off. 

d. Chiller On – For tests below ambient, an external chiller can be 
employed. This setting tells the machine to use chiller below the 
specified temperature. The chiller runs continuously once the 
temperature setpoint is below the Chiller On temperature. 
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5.4.1.2. Test Header Tab 
From Edit Machine Settings, select Test Header and the Test Header screen 
displays. 

 
Figure 5-4 Test Header Tab Screen 

Below is the explanation of this tab. 

1. Test Header – By adding values here, the user can make these values default 
so that these values do not have to be input every time the test information is 
input. 

a. Lab Name – Type the name of the Lab that is desired for every test 
report. Generally this is the name of the Lab where machine is installed. 

b. Customers List – Type names of Customers, so that users can pull 
customer information on the test Information screen. This way 
Customer name is always correct and consistent. 

c. Cement Type List – Same as above, but this refers to types of cement 
being used. 

d. Events SGS – Type up to four values of SGS for which the program 
should log the event and its corresponding time. 

e. Events Time – Type up to four values of time foe which the program 
should log the event and its corresponding value in SGS. 
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Currently, the events section of this tab is not available. It 
is necessary for the user to find SGS and Time events 
manually using the cursor. 

5.4.1.3. Motion Tab 
From Edit Machine Settings, select Motion and the Motion screen displays. 

 
Figure 5-5 Slurry Cup Paddle Motion Tab Screen 

In this tab the user can define and name different motions. A test profile is nothing 
but a collection of different motions running at different temperatures and pressure 
for a specific period of time. In this way a complex set of motor movements can be 
accomplished by using the defined motions. 

The process of defining a motion consists of the following: 

1. Give it a name – Please note that the first four motions cannot be renamed 
and are factory defaults. 

2. Select a unit for motor speed – If Rev./Min .is chosen, it is possible to set 
speeds from 1 RPM to 150 RPM. If Deg./Min. is chosen, you can set speeds 
from 0.216 Deg./Min. to 360 Deg./Min. 
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3. Set motor speed – Type speed of the motor in conjunction with the units 
chosen above. 

4. Select direction of the motor – The direction can be clockwise (CW) or counter 
clockwise (CCW). The direction is referenced by standing in front of the 
machine and looking down at the machine. 

5. Select Start Mode – The defined motion can be set to begin immediately or 
can be preceded by the zeroing process. The zeroing process returns the 
motor to its mechanical zero position before starting the motion as defined by 
steps 1 to 4 above. The zeroing process ensures that paddle is engaged at all 
times. The zeroing step is necessary every time the current defined motion is 
opposite of previous motion. 

By defining motions, probability of errors and mistyping is greatly reduced. To delete 
a particular motion, right click and select option to delete a particular motion. 

5.4.1.4. Constants Tab 
From Edit Machine Settings, select Constants and the Constants screen displays. 

 
Figure 5-6 Constants Tab Screen 

This screen controls motor and torque settings along with the sensor and sensor 
range selections. Note that these are default values and should not change. 
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1. Com Ports - In the Com Ports portion of the screen, use the arrow keys to 
view a list of available options for Motor Com, Torque Com, and Temp & 
Press Com. Alternatively, type the appropriate entry in the text boxes. 

Do not change the COM ports unless you are instructed or 
know the correct COM ports for each of the subsystems 

2. Torque Select - The machine can be configured to work with three different 
Torque sensor assemblies. Select the Torque Sensor that is installed on your 
machine and select appropriate range for the chosen sensor. 

3. Drive & Torque - This controls different aspects of the drive, filter, and 
torque for the test. For each of these text boxes, type the appropriate value or 
use the arrow keys to change the values up or down. The Drive ratio is fixed 
at 10 and Filter size is set to 20. The SGS Reference should not be changed. 

5.4.1.5. PID Tab 
From Edit Machine Settings, select PID and the PID screen displays. 

 
Figure 5-7 PID Tab Screen 
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This screen manages the configuration constants for the dynamic and static 
conditions for temperature control. Note that these are default values and only 
experienced technicians should change these settings. 

Click OK to save any changes and close this screen. Click Cancel to exit this screen 
without saving any changes. 

5.4.2. Profile Editor 
Click Edit > Profile Editor to display the Profile Editor screen to change various 
settings and values for the testing procedure. 

 
Figure 5-8 Profile Editor Screen 

The Profile Editor is the portion of the program that sets up the test sequence. 

The test sequence consists of the following parameters. 

1. HH - Type the hour portion of the step time. 

2. MM – Type the minute portion of the step time. 

3. Temp. – Type the final temperature to be attained at the end of step time. 
The program tries to set up a ramp so that the temperature is reached in 
the time specified. 
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4. Press. – Same as above but for pressure. 

5. Oper. Mode – This pull down list are motions previously defined on the 
Machine Settings screen. Selecting one of the defined motion steps 
automatically fills in the Speed section of that step. 

The Speed section cannot be edited in the Profile editor. 
All changes for motion have to set through the Motion tab 
on the Machine Settings screen. 

6. Speed – This section only provides information to the user as to what each 
Oper. Mode does. 

By right clicking, on the step number on the left side of the sequence, it is possible 
to add, delete, copy, and paste individual steps in the profile. 

The Stop Condition determines whether to stop the test when the sequence is 
complete or when the test attains a specified SGS target. Specify the Target SGS if 
the second option is chosen. 

Click OK to save any changes and close this screen. Click Cancel to exit this screen 
without saving any changes. 

5.5. Calibration Menu 
The Calibration Menu manages various calibration tasks for the MACS II system. 
This menu contains the following options. 

 Zero Drive 

 Calibrate Pressure 

 Calibrate SGS 

 Test Repeatability 

5.5.1. Zero Drive 
Click Calibration > Zero Drive to initialize the stepper drive to a known position. 
This operation is independent of other functions in the program. When the process 
begins, a dialog box displays. 

 
Figure 5-9 Zero Drive Adjusting Drive Mechanism Message 
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During the adjusting drive mechanism process, it is imperative to not adjust the 
drive system. When the adjustments are complete, the following dialog box displays. 

 
Figure 5-10 Reference Position Dialog Box 

Physically rotate the drive mechanism to the marked reference location. When the 
drive is properly set, select Zero to accept the new reference point. Alternatively, 
select Cancel to ignore. 

5.5.2. Calibrate Pressure 
Click Calibration > Calibrate Pressure to display the Calibrate Pressure screen. 
The screen contains two portions: Old Calibration and New Calibration. 

 
Figure 5-11 Calibrate Screen Old Calibration (Top) Portion 

The Old Calibration shows the values of current calibration. This way one can check 
the values and curve of pressure calibration. The New Calibration section is where, 
a new calibration takes place. 
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Figure 5-12 Calibrate Screen New Calibration (Bottom) Portion 

Follow this procedure to calibrate the pressure. 

1. Click Start. 

2. In the Actual PSI text box, type the actual pressure. If the Read PSI is 
reading a negative number, then type 0 (zero). 

3. Click Read. The process populates the first line in the Volts and PSI Table 
with zero value. The Start button changes to Next. 

4. Click Next. Wait for the pressure to stabilize and then type the actual pressure 
from a calibrated gauge in the Actual PSI. 

5. Click Read. Subsequent lines in the Volts and PSI Table are now populated 
with voltage applied and actual pressure generated due to it. 

6. Repeat step 4 until the Next button changes back to Start at which point, the 
whole calibration process starts repeating. 

Click Save to save any changes and close this screen. Click Cancel to exit this 
screen without saving any changes. While exiting this screen, the pressure vents out 
of the system to render the system safe. 
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SGS Calibration Setup 

1. On the Operate menu, click Cell Operations. 

 

2. When the Operate Cell dialog appears, click Open Cap. 

 

3. After the cap opens, verify that the O-ring and backup ring, located inside the cell cap, 
are in good condition, properly aligned, and lubricated with approved grease. 
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4. Fill the sample cup with water. Assemble the cup and rotate the coupling to ensure free 
movement. 

5. Click Open Drwr. 

6. Install the sample cup into the pressure vessel. Rotate the sample cup until it is locked 
in place. 

7. Fill the void between the top of the sample cup and the top of the pressure vessel with 
water to reduce the pressurization time. 

8. Click Close Cap, and then Close Drwr. 

9. Place a towel over the open thermocouple port to prevent excess water from coming 
out. 

10. Click Load Cell. Wait for the cell to load. 

11. Install the thermocouple and ensure the fitting is tight.  

12. Click Exit to close the Operate Cell window. 

 

To perform the SGS calibration, the sample cup must be in 
contact with the magnedrive coupling. The following steps show 
how to do that. 

13. On the Operate menu, click Manual Operations. 

14. On the Operate Manually dialog, enter the desired pressure in the Target Pressure 
box.  
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The pressure entered for calibration should be: 7000 psi for 0 to 
10,000 psi tests; 17,000 psi for 10,000 to 20,000 psi tests; and 
27,000 psi for 20,000 to 30,000 psi tests. 

15. Install the calibration fixture in the calibration position at the front of the unit. 

16. Properly align the guide height and bearing to the same height as the calibration pulley. 

17. Hook the ball of calibration string to the magnedrive calibration pulley, and then lay 
the other end of the string around the calibration fixture bearing guide. 

18. Type the letter d on the keyboard. This will change the units for motor rotation from 
revolution per minute to degrees per minute. 

19. On the Operate Manually window, enter 36 in the Deg/min box, and then select CW to 
begin clockwise rotation at 36 degrees per minute. Wait approximately 10 minutes for 
the string to completely rotate around the magnedrive pulley. 

 

20. When the rotation is completed, click on the rotating arrows (on the CW  button) to 
stop rotation of the magnedrive. 

21. Manually erase 36 and enter 0.2 in the Deg/min box. 

22. Click CW again to start rotating the motor and paddle clockwise at 0.2 deg/min. 

23. Select Exit. 

24. From Calibration menu, select Calibrate SGS. The Calibrate SGS window will 
appear. 
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5.5.3. Calibrate SGS 
Calibrating SGS must be done with Slurry cup installed and Cell locked. The paddle 
must be rotating at 0.2 deg/min to simulate a SGS test. Use the calibration fixture to 
hook the string so that appropriate Weights can be loaded. Before calibrating for SGS 
ensure that a speed of .2 deg/min turning in the direction of SGS must be 
implemented. 

Click Operate> Manual Operation then press‘d’ and enter 0.2 deg/min. As soon as 
you click CW the motor and paddle will start rotating.  

 Figure 5-13 Calibrate SGS Screen 
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The machine should not be unattended during the 
calibration process with a weight installed. Only 0.2 
deg/min revolution should be used for the deadweight 
calibration process. 

 

Click Calibration > Calibrate SGS to display the Calibrate SGS screen. 

This interface performs dead weight static gel strength (SGS) calibration. This screen 
is identical to pressure calibration procedure. With no weight hung on the pulley, 
follow this procedure to perform a SGS calibration. 

 

1. Click Start. 

2. Wait for torque to stabilize. In the Actual Torque text box, type the value of 
the Read Torque. 

3. Click Read. The process populates the Weights, SGS, and Torque Table 
with the appropriate values. The Start button changes to Next. 

4. Click Next. The system populates the next value of weight to be used in the 
Weight text box. 

5. Hang the actual dead weight on the calibration device. When the system 
stabilizes, the Read Torque value indicator turns green. Type this number in 
the Actual Torque text box. 

6. Click Read and the next line in Weights, SGS, and Torque Table is 
populated with appropriate Weight Torque and SGS values. 

7. Continue the process until the system reaches the last reading of 300 grams. 

Click Save to save any changes and close this screen. Click Cancel to exit this 
screen without saving any changes. 

5.5.4. Test Repeatability 
Click Calibration > Test Repeatability to display the initial Test Repeatability 
screen. Follow the prompts to complete the repeatability calibration. Click Cancel at 
any time to close this screen and exit the procedure. Click Next and Back to move 
between different steps. 
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Figure 5-14 Test Repeatability Step One Dialog Box 

1. Click Data File to display a standard Windows dialog box to select a file. 
Click Next for the next step. 

2. The next step in the Test Repeatability is to zero the drive. Click Zero Drive 
and follow Section 5.5.1 Zero Drive to zero the drive. 

 
Figure 5-15 Test Repeatability Step Two Dialog Box 
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3. The last step is to set parameters such as temperature, pressure and motor 
speed to begin the repeatability check. Generally, the motor is rotated at 36 
deg/min clockwise (CW) direction with no pressure and temperature. This 
generates one revolution every five minutes. So in thirty (30) minutes the 
unit performs six revolutions and it is then appropriate to asses the 
repeatability. 

 
Figure 5-16 Test Repeatability Step Three Dialog Box 
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4. Click Finish to begin the test. With motor turning, the system measures 
and displays the SGS value. It is possible to run repeatability tests for any 
length of time. Fann recommends to run at least two full revolutions at 
speeds less than 36 deg/min. 

5. To stop the test, click Stop Test on the main screen. 

6. Once the test stops, a dialog box displays the results and statistics of the 
test. 

7. Looking through the SGS Statistics without Outliers the SGS Variation 
should report to be less than +/- 36 SGS units and Std. Dev. of 12 SGS 
units. 

8. If the machine meets this criteria, the machine is repeatable. The Variation 
establishes the precision of SGS measurement. 

 
Figure 5-17 Test Repeatability Results Screen 

9. Click Exit to close this screen and return to the main screen. 
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5.6. Operate Menu 
The Operate Menu is where the user controls the physical actions of the device. 
This section contains the following options: 

 Cell Operations 

 Valve Operations 

 Manual Operations 

 Release Pressure 

5.6.1. Cell Operations 
Click Operations > Cell Operations to display the Cell Operations dialog box. 

 
Figure 5-18 Cell Operations Dialog Box 
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The Cell Bottom, Cell Top (Cap) and Drawer assemblies can be operated and moved 
automatically. This is necessary to open the cell for loading the Slurry cup and 
locking the cell back. The graphic on the screen pictorially depicts the position of the 
cell. 

1. Load Cell – The Load Cell operations raises the Cell and turns it to lock the 
Bottom cell inside the Top Cell assembly. 

2. UnLoad Cell – This is reverse of Load Cell operation. The cell is turned and 
then lowered. 

3. Update Status – This enquires the status of the cell and updates the graphic 
on this screen. 

4. Open Cap, Close Cap – These buttons raise and lower the Cell top and the 
lid. This helps in replacing the O-ring and the back up ring. 

5. Unlock, Lock – These two buttons rotate the cell to lock and unlock with the 
Cell Top. 

6. Raise Cell, Lower Cell – These buttons raise or lower the cell and mates or 
unmates the Cell Bottom to Cell Top. 

7. Open Drwr, Close Drwr – These buttons push in or pull out the drawer from 
the frame so that a slurry cup can be loaded inside the cell. 

Note that the MACS II unit does not perform certain 
operations due to mechanical interference. For example, if 
the cell is raised, then it is not possible to pull out the 
drawer. The software flags such an operation as illegal. 

 

If the cell is under pressure, none of the operations can be 
performed until the pressure is released. In such a case all 
elements of the screen are unavailable (gray). 

8. Click Exit to close this dialog box. 
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5.6.2. Valve Operations 
Click Operations > Valve Operations to view the Valve Operations screen. 

 
Figure 5-19 Valve Operations Screen 

This screen allows the user to interactively operate the various valves in the system. 
Every valve (colored Red/Green) is clickable and operates the respective valve. 

Normally the automatic process governs the operations of all these valves, but for 
diagnostic and evaluation reasons, the user may operate these valves. Once on this 
screen the user is in control of the valves and must have adequate knowledge and 
understanding of Hydraulic/pneumatic system to operate these valves. 

This interface does not permit certain activities due to protocol and/or safety factors. 
Click Exit to close this dialog box. 
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5.6.3. Manual Operation 
Click Operations > Manual Operations to access the Manual Operations dialog 
box. 

 
Figure 5-20 Operate Manually Dialog Box 

This screen allows control of temperature, pressure and motor subsystems 
independently and immediately for verification and diagnostics. 

 Target Pressure – Type a pressure setpoint and the machine starts pumping. 
To release pressure completely, type a value of 0 (zero). Ensure that the cell 
is closed and sealed before applying pressure as water will pump into the cell. 

 Target Temp. – Type a temperature setpoint and the cell starts heating and 
trying to get to the set temperature as fast as it can. To turn off the heater, 
type a value of less than 40°F. The red indicator signifies that heater is off. 

 Rev/min | Deg/min – Type a speed for the motor. Press D to change the 
units to Deg/min or press R to change the units to Rev/min. Note that the for 
Deg/min units, the settable speed is 0.216 deg/min to 360 deg/min and for 
Rev/min units, the settable speed is from1 RPM to 150 RPM. 

 CW, CCW – Click CW to rotate the motor in a clockwise direction. Click CCW 
to rotate the motor in a counter-clockwise direction. 

 Lock Drive, Unlock Drive – Click Unlock Drive to unlock the drive 
mechanism to free the motor and rotate the drive and paddle assembly as 
necessary. Click Lock Drive to lock the drive. 

Click Exit to close this dialog box. 
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5.6.4. Release Pressure 
Click Operations > Release Pressure to instruct the machine to allow pressure to 
escape. If the temperature above the Safety Min. Temp. as set in Section 5.4.1.1 
General Tab, the system will not release any pressure. 

5.7. Help Menu 
The Help Menu provides access to help and support topics for the MACS II software. 
This menu contains the following options. 

 Online Help 

 Check for Updates 

 About 

5.7.1. Online Help 
Click Help > Online Help to display the on-line help document. This feature has not 
been implemented yet. 

5.7.2. Check for Updates 
Click Help > Check for Updates to begin the process to update the MACS II 
software. 

5.7.3. About 
Click Help > About and a dialog box containing pertinent company and software 
version displays. 

5.8. Start Test Wizard 
The Start Test Wizard helps a novice or expert user step through various rigors of 
starting a test. The wizard walks the user through a series of steps to ensure that all 
significant procedures are completed before the test to obtain meaningful results. 

To launch the Start Test Wizard, click Start Test. The Start Test button is at the 
upper-right of the MACS II software desktop. 

Several buttons at the bottom of the wizard provide navigation through the process. 

 Back – Return to the previous step in the wizard. This is 
unavailable if you are on the first step of the process. When 
the process moves to the second step, Back becomes active.  

 Next – Proceed to the next step in the wizard. Note that when 
procedure is on the last step, this button changes to Finish.  
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 Finish – Close the wizard and initiate the test. 
 

 Cancel – Exit the wizard without performing test. If chosen, it 
is necessary to go through the steps to restart the test.  

 Help – Launch context-sensitive help. 
 

Execute the following steps to start the test. 

5.8.1. Step One 
The first step in the process is to ensure all the relevant information about the test. 

 
Figure 5-21 Test Information Screen 

8. Input information about the test. The following fields are mandatory. 

 Lab Name 

 Project name 
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 Test ID 

 Tested By 

 File name - Click Data File to open a standard window file dialog and 
navigate to the folder to save the data file. Type a file name and click OK. 

 
Figure 5-22 Mandatory Text Boxes 

9. Following are the optional fields. 

 Request ID 

 Customer – This is a free text field with a drop down list. This allows 
selection of a customer from a list. 

 Well No. 

 Rig 

 Casing/Liner Size 

 Job Type 

 Cement Type – This performs in the same manner as the Customer field. 

 Cement Weight 

 Comments 

 File Path - This field is input using Data File as explained previously. 
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 Events SGS – Type SGS values at which to record the time 

 Events Time – Type the time in hh:mm format at which to record the SGS. 

Default settings for Customer List, Comment Types, 
Strength, and Time Events can be set by the Configure 
System menu item from the main screen. Refer to Section 
5.4.1.2 Test Header Tab for more information. 

5.8.2. Step Two 
This prompts to verify the test profile for the test. Refer to explanation in Section 
5.4. Edit Menu to understand this step. It is possible to modify the whole profile in 
this step. 

 
Figure 5-23 Temperature Reference Screen 
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5.8.3. Step Three 
This step performs the task to zero the drive of the motor. 

 

Follow instructions in Section 4.5.1 and zero the drive. 

5.8.4. Step Four 
At this point, prepare the cement sample and load it into the cell. Notice that the cell 
operations screen is embedded here to perform the relevant steps to load the slurry 
cup. Refer to Section 5.6.1 Cell Operations to understand how to operate the cell. 
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Note that all cell operations is unavailable (gray) if the cell is found to have pressure 
in it. 

 
Figure 5-24 Cement Sample Cell Dialog Box 

5.8.5. Step Five 
At this point in the process, it is possible to start the test. Before starting the test, 
ensure that certain physical actions are complete before beginning the test. 

In this step, it is mandatory to verify the check items. If all the check boxes for the 
items are chosen, Finish becomes available. Click Finish to start the test. 
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If any of the verifications fail, make appropriate changes or Cancel to exit the wizard. 

 
Figure 5-25 Wizard Complete Screen 

In addition to the check boxes, the user can set initial parameters for pressure and 
speed the unit needs to attain before the test can begin. 

Type the values in the corresponding fields to set initial test parameters: 

 Pressure 

 Speed 

 Dir 

 

Click Finish to exit the wizard and proceed with the test or click Cancel to exit the 
wizard without starting the test. 
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5.9. Test Run 
After the Start Test wizard completes, the software sets the initial parameters for 
the test run, as follows: 

The software sets the initial pressure, prompting 
with the dialogs shown in the images on the right. 
To abort the test at this point click “Abort Test” or 
to start a test without waiting for the initial steps, 
click on “Skip This” 

 

 

After the initial settings have met, the test starts. During the test, the machine steps 
through the test profile, managing the temperature, pressure and motor speed. It 
continually monitors SGS, plots the graph and logs the data. 

5.10. Stop Test 
To stop a test when the status indicator shows Running mode, do the following: 

1. Click Stop Test (Upper-right of the main screen). 

2. A dialog box displays to confirm the action. Click Yes to stop the test or No to 
cancel the stop test operation. 

3. A “Test is Over” message displays. Click OK. 

4. Once test has stopped, the machine may begin auto cooling if this has been 
enabled. 

5. The pressure on the cell will be held to the last setpoint. 

6. If the cell is sufficiently cool, release the pressure and open the cell to take out 
the slurry cup. 

After stopping the test, it is mandatory is release the 
pressure. Refer to Section 5.6.4 Release Pressure  for 
more information. 
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6.1. Start Test Wizard Module 
The process of starting a test can be followed by invoking the Start Test Wizard. 
Press the Start button to begin the test. Fill in all pertinent information and proceed 
through the Start Test wizard up to step three. Stop at step four - Load Cement 
Sample. Unload the cell and open the drawer in preparation to load the slurry cup in 
the device. 

6.2. Physical Equipment Activity 
With MACS II software is on the Load Cement Sample step, attention focuses on 
the physical unit itself. 

Verify that the cell O-ring and backup ring are in place. Change and lubricate if 
necessary. 

Prepare the sample. 
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Figure 6-1 Complete Slurry Cup and Paddle Assembly (Eng. Drawing #101636768) 
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Prepare the SGS slurry cup. 

 

Figure 6-2 Slurry Cup and Paddle (Eng. Drawing #101636768) 

1. Grease the plug threads and bottom sleeve threads that accepts the base. 

2. Install the bottom (#1-6) and top baffles (#1-7), O-ring (#1-8), top cap (#1-
9), and lock ring (#1-12) in the top of the slurry cup as shown in the assembly 
(DWG # 101636768). 

The valve stem (#1-10) and retaining ring (#1-11) should 
be permanently installed in the top cap. 

3. Insert the paddle assembly (#2) in the slurry cup bottom insuring the shaft O-
ring (#7) is in place. 

4. Place the slurry cup on a slurry cup holder to tighten the slurry cup lock ring 
into the slurry sleeve (#1-5). 

5. With the slurry cup upside down on the cup holder, pull down on the valve 
(#1-10) and fill the cup with slurry up to the surface just below the thread 
relief. 

6. Momentarily push up on the valve, until slurry flows from the top of the cup to 
vent any air that may be trapped in the isolation baffle area. 
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7. Pull down on valve to reseal. 

8. Reciprocate the paddle assembly up and down several times to work additional 
air out of the paddle area. 

9. Add additional slurry as needed to insure a full slurry cup taking care not to 
get slurry in the thread area. 

10.Install the slurry cup base (#1-3) with gasket (#1-4) if slurry does not come 
out of the of the plug hole in the base, add slurry then install and tighten the 
plug (#1-1) with gasket (#1-2) wiping excess slurry from base. 

11.Remove slurry cup and turn right side up and install the coupling alignment 
retaining ring (#4) in the groove on the top of the paddle shaft. 

12.Install the cup coupling (#3) on paddle shaft until it rest on the retaining ring 
insuring to align the coupling setscrews up with the flats on the shaft and 
tighten. Spin the coupling to insure no excessive drag on the shaft. 

13.Place the filled slurry cup in the MACS II pressure chamber. 

14.To install the cup, lower the cup with the supplied bail into the pressure 
chamber and rotate the cell until the pins on the bottom of the cup engage in 
the holes on the plate in the bottom of the pressure chamber. 

15.Close the cell drawer, load the cell and install the sample thermocouple. 

6.3. Cement Test 
At this point, both the software and the hardware are ready to test the cement. The 
next step in the process returns to the software. Proceed with Step Four of the Start 
Test wizard and pull the drawer in and load the cell. 

Proceed with step five of the wizard and start the test. Click Finish. 

At this point test has begun and results are being logged in the file specified. 
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7.1. MACS II Software 
The MACS II software controls the functionality of the physical machines.  

In addition to controlling the software, there is functionality available for viewing and 
understanding data. 

Right click in the Results Graph to invoke a set of tools. The following tools are 
available to analyze data. 

 Show Cursor 

 Show Bc (for factory use only) 

 Show Torque 

 Show Cursor 

 Autoscale X 

 Autoscale Y 

7.1.1. Show Cursor 
Click in the results graph and select this option from the list. The cursor appears as a 
vertical line. Drag this cursor along the time axes and the corresponding values of 
the cursor display at the top of the results graph, in dedicated cursor boxes. 

7.1.2. Show Torque 
Select this option to display the torque values. 

7.1.3. Autoscale X 
If this option is chosen, the X-scale performs an auto-scale to accommodate the full 
test time and display the graph. De-select this option to not auto-scale. The user can 
now type any value on the left and right axes to view a section (or slice) of time 
from the whole test. 

7.1.4. Autoscale Y 
This option operates on individual Y axes. Position the cursor on any Y-axis, right 
click and select/deselect this option. If auto-scale is deselected for a particular Y-
axis, type values on the scale endpoints to display a section of data on the Y-axis. 

7.2. Data Manager Software 
The Data Manager software is available to view, analyze, and print the data after the 
test is complete. The Data Manager also allows manipulation of test data for different 
units and to customize the report as necessary. It also allows printing and importing 
data to TXT and CSV formats for import into spreadsheet programs. 
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7.3. Data Interpretation 
Interpreting the data is easy because the individual graphs for temperature, 
pressure, SGS, and Torque are color coded to respective scales. The software plots 
all of the data with respect to these parameters. 

The data contains meaning only during the Gel Stage. Data collected during 
conditioning is of no value. 

Analysis and interpreting different SGS values is beyond the scope of this manual. 
Please refer to a Subject Matter Expert (SME) for assistance on this subject. 
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8.1. Preventive Maintenance 
Preventive maintenance can be grouped into the following categories: 

 Pneumatic 

 Hydraulic 

 Mechanical 

8.1.1. Pneumatic Maintenance 
Every 30 days, inspect the inline air filter for water. If water is present, adjust the air 
pressure down and up gradually to engage the designed purge feature. 

8.1.2. Hydraulic Maintenance 

8.1.2.1. Inline Filter 
The inline (30 microns) filter should be cleaned every thirty (30) days of operations. 
If the inline filter is damaged or deformed, replace it. Fann recommends keeping a 
spare filter for this purpose. 

8.1.2.1.1 Filter Disassembly 

8.1.2.1.1.1 Turn bowl off in counter-clockwise direction. Never use any tool other 
than a strap wrench to remove the bowl. 

8.1.2.1.1.2 Pull element off post. 
  

8.1.2.1.1.3 Remove seal from element. 
 

8.1.2.1.1.4 Remove seals (o-ring & backup) from bowl. 

8.1.2.1.2 Filter Element Cleaning 

8.1.2.1.2.1 Remove external dirt in a separate container with cleaning fluid, and 
light brush. 

8.1.2.1.2.2 Submerge the filter for thirty minutes in an approved cleaning fluid. 

8.1.2.1.2.3 Following the soak, purge element from inside to outside with clean 
compressed air or similar clean gas.  DO NOT EXCEED 120 PSI. 

8.1.2.1.2.4 Remove any remaining cleaning solution by dipping the element in 
isopropyl alcohol or drying appropriately. 
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The element life is based upon cleaning cycles and pressure drop.  The 
estimated life of the element is 10 to 15 cleaning cycles.  If the element has 
exceeded this level, discard and replace. 

  
 Recommended cleaning fluids are acetone, mineral spirits and a variety of 

others.  Halo-carbon grease, Krytox, and silicone are the only recommended 
lubricants.    

8.1.2.1.3 Filter Reassembly 

8.1.2.1.3.1 Lubricate and install new bowl seals.  The backup ring is installed 
closest to the threads. 

8.1.2.1.3.2 Lubricate a new seal with a compatible lubricant and install into outlet 
port of element. 

 

8.1.2.1.3.3 Slip element over mandrel.  Be aware that teflon (T) o-rings are difficult 
to engage. 

8.1.2.1.3.4 Inspect all threads for debris and clean thoroughly. Lubricate the 
threads on head and bowl and assemble. Never use any tool other than a 
strap wrench to turn the bowl. When screwing the bowl into the head it 
should take approximately 7-1/2 turns of the bowl to reach the point 
where the bowl seal engages the head.  At this point there will be 
noticeable resistance when turning the bowl. It should take approximately 
1-5/8 turns of the bowl past this point to reach metal-to-metal contact of 
the bowl face with the head. The bowl is properly seated in the head at 
this point.  If this metal-to-metal contact is not achieved, the unit is not 
properly assembled and the bowl must be unscrewed and examined to 
determine if there is a problem with the installation of the seals or if there 
is some type of debris in the threads. 

8.1.2.1.3.5 Correct the problem and repeat this step if necessary.  

8.1.2.1.3.6 After assembly, check for leaks while re-pressurizing. 

8.1.2.2. Tescom High Pressure Valve Repair  
The following items are needed to perform valve repair on the MACS: 
 2 ½ inch open end wrench (101582697) 
 2 inch open end wrench (101582698) 
 Repair Kit (101629337) 
 Torque Sensor Tool (101629332) 
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 Loctite 271 
 A light lithium or silicone based grease 

8.1.2.2.1 Locating the Tescom high pressure valve 
The Tescom high pressure valve can be most easily accessed from the 
back of the unit. 

 

Figure 8-1 High Pressure Valve Location 

8.1.2.2.2 Disassembling the High Pressure Valve 
8.1.2.2.2.1 Disconnect power, air, and water from the MACS. 

8.1.2.2.2.2 Ensure there are no high temperature surfaces near the high pressure 
valve.  Use a temperature measuring device to safely check for heated 
surfaces. 
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8.1.2.2.2.3 Disconnect the electrical plug and inlet tubing as shown in the figure 
below. 

 
Figure 8-2 Items to Disconnect 

8.1.2.2.2.4 Use the 2 and 2-1/2 inch wrenches for valve disassembly. 

8.1.2.2.2.5 Ensure that there is ample clearance to use the wrenches. 
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8.1.2.2.2.6 Loosen the right hand threaded body assembly from the air actuator 
assembly. 

 
Figure 8-3 Wrenches on Valve 

8.1.2.2.2.7 Spin the valve off by hand once it is loosened. 

8.1.2.2.2.8 Remove and set the air actuator assembly aside. 

 

Figure 8-4 Removing Air Actuator Assembly 

8.1.2.2.3 Rebuilding Internal Valve Body 
The following steps are performed to rebuild the internal valve body 
including all stems, seats, and seals. 
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8.1.2.2.3.1 Locate and remove the internal sensor assembly. 

 

Figure 8-5 Internal Sensor Assembly Location 

  

 

Figure 8-6 Internal Sensor Assembly Removal  
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8.1.2.2.3.2 Remove the Seat Retainer with a medium flat blade screw driver. 

 

Figure 8-7 Seat Retainer  

8.1.2.2.3.3 Lubricate and reinstall the threads.  After the lubrication, replace the 
seat in the retainer. 

 

Refer to the valve drawings and BOM in this 
document for detailed parts and lubrication 
information. 

 

 

Figure 8-8 - Lubrication of Threads  



 
 

MACS II User Manual 
 

 

101796668 Revision E 90 

8.1.2.2.3.4 Use the torque sensor tool to disassemble and reassemble the sensor. 

 

Figure 8-9 Torque Sensor Tool  

8.1.2.2.3.5 Using soft jaws, chuck the flats on the sensor assembly in vise with the 
stem facing up. 

 
Figure 8-10 Vise with Soft Jaws  
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8.1.2.2.3.6 Unscrew the sensor from the spring pad. 

 

Figure 8-11 Spring Pad 

8.1.2.2.3.7 Replace the sensor and valve parts (as shown below).  Reassemble the 
parts. 

 

Figure 8-12 Valve Parts 
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Figure 8-13 Stem and Spring  

 

Figure 8-14 O-ring and Backup Ring  
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8.1.2.2.3.8 Before assembling the Spring Pad and Sensor, apply one drop of Loctite 
on the threads. 

 

Figure 8-15 Loctite Application 

8.1.2.2.3.9 Reassemble in reverse order using the valve drawings as a reference. 
 

 
Observe the torque and lubrication 
requirements in the drawing notes. 

 

 

Figure 8-16 Reassembled Sensor 

8.1.2.2.3.10 Flush all high pressure lines before the filter to remove any debris and 
sediment. 

8.1.2.2.3.11 Replace the filter element as described in the previous section. 
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8.1.3. Mechanical Maintenance 
Before every test, inspect the cell body for sediments, dirt, and other abnormalities. 
Use soapy water and brush the chamber with a soft brush. Do not use a wire brush 
as this might damage the sealing area. Upon completion, vacuum the soap residue 
from the unit. Do not flush the water through the drain line as this could clog the 
drain line and high-pressure relief valve.  

Check the O-ring seal and back-up ring on the cell top cap to verify that it is 
lubricated and seated. 

Inspect the timing belt for any fraying and/or wear indicating increased torque. 

8.2. Troubleshooting 
This section lists potential problems with the MACS II unit and solutions. If the 
problem is not correctable, contact Fann for assistance. 

230 volts may be present so only a qualified technician 
should perform these actions. 
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Item Problem Cause Solution 

1. MACS II unit does not power 
up. No fan or controller 
displays. 

Main power inlet 
and plug. 

Check plug and 
circuit breaker panel 
for 230 volts 

 MACS II power 
switch “off” at rear 
of unit. 

Turn “on” switch. 

 Circuit breaker “off” 
at rear of unit. 

Turn “on” breaker. 

2. MACS II unit powers up, but 
fan does not operate. 

Remove panels to 
gain access and 
check connector 
and wiring from fan 
to terminal block. 

Reconnect or 
replace wiring. 

 Bad fan. Replace fan. 

3. MACS II unit powers up, the 
fan is “on”, but there is no 
display on controller. 

Check connector 
and wiring from 
controller to 
terminal block. 

Reconnect or 
replace wiring. 

 Bad controller. Replace controller. 

4. Communication error when 
trying to connect. 

USB cable(s) not 
connected. 

Close MACS II 
program, reconnect 
cables, wait ten 
seconds, restart 
program and 
connect. 

 Possible problems 
with internal 
Edgeport 
connectivity. 

Inspect and verify 
Edge-port 
communication 
ports are correct 
with supplied 
Edgeport 
Configuration Utility 
software. 

 Possible problem 
with NI cDAQ-9172 
connectivity. 

Inspect and verify 
NI cDAQ 
communication 
ports are correct 
with supplied 
measurement & 
automation 
software. 
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Item Problem Cause Solution 

5. After selecting Connect unit 
goes into yellow Safe mode. 

Emergency stop 
button is pressed. 

Twist emergency 
stop button 
counterclockwise, 
disconnect, and re-
connect to initialize 
the torque sensor. 

6. Yellow Safe mode indication 
during test. 

Emergency stop 
button has been 
pressed. 

Twist emergency 
stop button 
counterclockwise. If 
a test has been 
started, abort it and 
start a new test. 
There is no recovery 
from this situation. 

7. MACS II does not hold 
pressure at low values <3000 
psig but holds at high 
values>8000 psig. 

Bad Tescom valve 
seat. 

Rebuild Tescom 
valve with Soft 
Goods Kit (P/N 
101629340). 

8. MACS II holds pressure at low 
values <3000 psig but does 
not hold at high values>8000 
psig. 

Bad Tescom valve 
stem and seat. 

Rebuild Tescom 
valve with Repair Kit 
(P/N 101629342). 

9. MACS II does not hold any 
pressure but does pump. 

No water supply. Turn on water. 

 Bad Tescom valve. Rebuild Tescom 
valve with Repair Kit 
(P/N 101629342). 

 Leaking cell or mag 
drive o-ring. 

Replace o-ring. 

 Leaking dump or 
manual valve. 

Replace dump valve, 
tighten, and/or 
replace manual 
valve. 

 Leaking high 
pressure fittings. 

Look for leak, 
tighten or replace. 

 

High pressure is present. Before manual disassembly, 
remove pressure by opening the manual valve or, as a last 
resort slowly loosen a high pressure ¼ inch fitting ensuring 
the temperature is below 100°F. Use proper PPE for safety. 
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10. MACS II does not depressurize. Dirty inline filter. Clean or replace 
cartridge filter (P/N 
101626358). 

 Clogged high 
pressure line from 
bottom of cell or 
1/8th line to filter. 

Disconnect fittings 
and remove clogged 
lines. Clean by 
reverse pressure 
flow or replace lines. 

11. MACS II does not? Pump when 
pressure is requested. 

No air supply to 
system or regulator 
turned down. 

Connect air supply 
and ensure regulator 
is set at 100 PSIG. 

12. Cell and drawer movements 
are inoperable. 

No air supply. Connect air supply 
or turn up air 
regulator. 

 No 24 VDC power 
supplied to 
solenoids. 

Inspect 24 VDC 
supply in electronic 
enclosure, check 
associated 
connectors and 
wiring to/from 
terminal blocks. 

13. Cell does not engage properly. Cell, top cap or 
drawer misaligned. 

Refer to alignment 
procedures in 
manual. 
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9.1. MACS II Tool Kit 
 

Find # Name Drawing/Rev Quantity Reference Description 

 101708266  1  KIT, TOOL, MACS II 

0001 101582697 / A  1.0 101582697 WRENCH, 2.00 INCH, OPEN END 
AND SOCKET END  

0002 101582698 / A  1.0 101582698 WRENCH, 2.50 INCH, OPEN END 
AND SOCKET END  

0003 101710008 / A  1.0 101710008 WRENCH, 5/8 INCH, OPEN END 
AND SOCKET END  

0004 101710009 / A  1.0 101710009 
WRENCH SET ALLEN 13-PC, .050 
THRU 3/8 INCH, W/ PLASTIC 
INDEXED CADDY  

0005 101623038 / A  1.0 101623038 WRENCH, OIL FILTER, NYLON 
STRAP  

0006 101629332 / A  1.0 101629332 
TOOL, SENSOR TORQUE, 20,000 
PSIG AND 30,000 PSIG, TESCOM 
REGULATOR  

0007 100072377 / A 800.61388 / A 1.0 800.61388 BAIL, SLURRY CUP, 50 KSI 
CEMENT CONSISTOMETER  

0008 100072505 / E 800.62143 / U 1.0 800.62143 HOLDER, SLURRY CUP, HP-HT 
CONSISTOMETER  

0009 100072506 / D 800.62144 / C 1.0 800.62144 WRENCH, SLURRY CUP, HP-HT 
CONSISTOMETER  

0010 101711419 / A  1.0 101711419 
TOOL, ALIGNMENT, TORQUE 
MEASUREMENT SYSTEM, 50 OZF 
IN, 10000 RPM 12 VDC  

0011 101711420 / A  1.0 101711420 
BEARING REMOVAL TOOL, 
SNAPTITE MAGNEDRIVE30B-
1957  

9.2. MACS II Accessory Parts Kit 
 

Find # Name Drawing/Rev Quantity Reference Description 

 101708367  1  KIT, ACCESSORY PARTS, MACS II 

0001 204129 / A  5.0 C7006 FUSE 10 AMP EUROPEAN 5MM X 
20mm MOD  

http://cwiprod.corp.halliburton.com/cwi/View.jsp?id=17645.25560.6599.63659
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Find # Name Drawing/Rev Quantity Reference Description 

0002 101626358 / A  1.0 101626358 FILTER, 40 MICRON, 304 WIRE 
MESH, 3B FILTER  

0003 101630287 / A  1.0 101630287 
KIT, 3 ORINGS FOR P8791-HP-
40WEV 
ORING 212V, 138V, AND 138VP  

0004 101629342 / C  1.0 101629342 
KIT, REPAIR, TESCOM 54-
21N0T44A-074 REGULATOR, 
30,000 PSIG  

0005 101629340 / B  1.0 101629340 KIT, SOFT GOODS, 30,000 PSIG, 
TESCOM REGULATOR  

0006 204816 / A  1.0 F4160 GREASE HIGH TEMP PERMATEX 
82325  

0007 210435 / A  1.0 87009 LUBRICANT HIGH TEMPERATURE 
1 OUNCE TUBE  

0008 101594774 / D 101594774 / D 1.0 101594774 BACKUP RING, PRESSURE 
VESSEL, MACS II  

0009 206712 / A  12.0 11512 

ORING 3 X 3-1/4 V-23 234-90 
VITON 90 DUROMETER 
USE ENCLOSED SPEC SHEET FOR 
DUROMETER  

0010 101710014 / A  6.0 101710014 
O-RING, ULTRA PARAFLUOR, ID 
2.984, COLOR WHITE, SIZE 2-
234, DUROMETER 75  

0011 101443948 / C 101443948 / C 1.0 101443948 BACKUP RING, MAG DRIVE, MACS 
II  

0012 101710015 / A  2.0 101710015 
O-RING, ULTRA PARAFLUOR, ID 
.739, COLOR WHITE, SIZE 2-018, 
DUROMETER 75  

0013 101667558 / B 101667558 / B 1.0 101667558 
THERMOCOUPLE, J TYPE, MACS 
II, TOP, 30000 PSI RATED, 56 IN 
LEADS  
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9.3. MACS II Calibration Kit 
 

Find # Name Drawing/Rev Quantity Reference Description 

 101780235  1  KIT, CALIBRATION, MACS II 

0001 204178 / A  1.0 D4026 WEIGHT HANGER 50gm 
ALUMINUM  

0002 204179 / A  1.0 D4027 WEIGHT SLOTTED BRASS 
50gm  

0003 204180 / A  1.0 D4028 WEIGHT SLOTTED BRASS 
100gm  

0004 204181 / A  1.0 D4029 WEIGHT SLOTTED BRASS 
200gm  

0005 207781 / A  1.0 31278 BEAD CALIBRATION KIT 
3/32in. DIA  

0006 101780256 / A  10.0 101780256 

Braided line, 20lb Test 
SPIDERWIRE STEALTH 
1085179 
MFG PART NUMBER SS20Y-
150  

9.4. MACS II Schematics 
The following pages contain various pertinent schematic drawing. Note that the 
schematics are also included in larger, easier-to-read format on the CD.
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 Parts List
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10.1. Master Assembly 101677665 
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Find 
# 

Name Drawing # Quantity Description 

  101677665 101677665 
D00339141 

 MASTER ASSEMBLY, MACS II ANALYZER 
DOES NOT INCLUDE COMPUTER. 

1 101595348 101595348 1 MECHANICAL ASSEMBLY, MACS II, FANN 

2 101676548 D00335007 
D00335008 
D00335006 
101676548 

1 ASSEMBLY, ELECTRICAL BOX, MACS II 

200 101780235  1 KIT, CALIBRATION, MACS II 

201 101708266  1 KIT, TOOL, MACS II 

202 101708367  1 KIT, ACCESSORY PARTS, MACS II 

203 101643568  1 SOFTWARE, DATA VIEWER FOR FANN MACHINES 

204 101708267  1 SOFTWARE, MACS II 

301 101443941 101443941 1 MAIN POWER CORD, 30 AMP, 250 V, 6 FT LONG 

302 101367493  2 CABLE, USB, 6FT, 1.8 METER, TYPE A TO TYPE B 

303 101262244  10 SCREW, THREADED, BUTTON HEAD SCS (US) - NO. 8 -32 UNC x 0.25 - 18-8 SS 
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10.2. Electrical Box Assembly 101676548 
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Find # Name Drawing Quantity Description 

  101676548 101676548  
D00335008 
D00335006  
D00335007 

 ASSEMBLY, ELECTRICAL BOX, MACS II 

1 101443963 101443963 1 CHASSIS, ELECTRICAL BOX, MACS II 

2 101443926 101443926 1 FILTER, INTAKE, 9.38 X 7.50 X .50 THICK FRAME, 30 PPI GRAY QUADRAFOAM II 

3 101443969  1 TEMPERATURE CONTROLLER, DUAL CHANNEL, 1/4 DIN, PANEL MOUNT 

4 101462041  4 FEED THRU, COMBICON/PHOENIX CONTACT 1852163 

5 101461990  4 PLUG, COMBICON/PHOENIX CONTACT 1825640 

6 101461967  4 PLUG, COMBICON/PHOENIX CONTACT 1778124 

8 101443967  1 STEPPER DRIVE, MICROSTEPPING 

9 101443970  1 SOLID STATE RELAY, DUAL OUTPUT, 25 A, OUTPUT 24-280 V AC, INPUT 17-32 V 
DC 

10 101443958  1 CONVERTER, USB TO 4 232/422/485 SERIAL PORTS 

11 205723  1 STEP DOWN TRANSFORMER 230 VAC TO 115 VAC 60HZ 1KW CAPACITY W/ 
RECEPTACLE & LINE 

12 101450812  1 SWITCH, DOUBLE POLE, ROCKER 

13 100021372  1 RECEPTACLE, 3 WIRE GROUNDING, FLANGED INLET, TWIST LOCK, 250 VAC, OR 
DC, 30 AMP, LEXAN CASE 

14 101451383  1 CIRCUIT BREAKER, TWO POLE, SERIES TRIP, 30 AMP 

15 101451384  1 RELAY, TWO POLE, 30 AMP, 220/240 VAC, PANEL MOUNT 

16 101443929  1 OUTLET 5-15R, PANEL MOUNT, SNAP-IN, FRONT SIDE, SOLDER TERMINAL 

17 101631176  2 USB PANEL MOUNT, TYPE B CABLE, LENGTH 3 FOOT 
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Find # Name Drawing Quantity Description 

18 101613246  1 FAN, 4.73IN SQ X 1.50IN THK, 230 VAC, 105 CFM 

19 100033128 70.81602 1 RAIL, MOUNTING, 35MM, X 1 METER, DIN,46277, SYMMETRICAL 

20 101391619  2 CLAMP, END, UNIVERSAL, FOR 35 MM X 7.5 MM MOUNTING RAIL, E/NS 35 N 

21 101462159  2 COVER, 2.2MM X 48.5 MM PHOENIX CONTACT 3030417 

22 101483688  30 Feed-through terminal blocks with spring-cage connection, cross section: 0.2 - 
2.5 mm, width: 5.2 mm, color: gray 

23 101634351  4 SPRING CAGE GROUND TERMINAL BLOCK, AWG 24 TO 14, YELLOW GREEN 

24 101483689  24 Plug-in bridge for cross-connections in the terminal center, 2-pos., color: Red 

25 101761371  1 POWER SUPPLY, 24V, 5 AMP, LED DISPLAY, DIN RAIL MOUNT 

27 101443927  1 RELAY, MULTIFUNCTION TIME, UNIVERSAL SUPPLY VOLTAGE AC/DC 12 - 240 V, 
OUTPUT CONTACT SPDT OR DPDT 16 A, DIN RAIL MOUNTED 

28 101443956  1 CONTACTOR, 4 POLE, 30 AMP, 240V AC COIL 

29 204387  1 GUARD FAN FINGER f/120mm MUFFIN 

30 101752942  1 CIRCUIT BREAKER, 10 AMP, PUSH BUTTON, 125-250 VAC/32 VDC 

31 101462088  1 DATA ACQUISITION SYSTEM, 8-SLOT CHASSIS FOR COMPACT DAQ NI cDAQ-
9172 

32 101462060  1 ANALOG OUTPUT MODULE NI cRIO-9263 

33 101443939  2 DIGITAL INPUT AND COUNTER/TIMER MODULE NI cRIO-9422 

34 101462057  2 DIGITAL OUTPUT AND RELAY MODULE NI cRIO-9472 

35 101673608  1 CONNECTOR, GEMINI, 26P, WITH TERMINALS 

36 101673609  1 CONNECTOR, GEMINI, 50P, WITH TERMINALS 
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Find # Name Drawing Quantity Description 

37 101443936  1 KIT, PANEL HOUSING, 6 POSITION, 22A, 400V, 22-12 AWG WIRE 

38 101443935  1 KIT, CABLE HOOD, 6 POSITION, 22A, 400V, 22-12 AWG WIRE 

39 101443937  3 PANEL THERMOCOUPLE JACK, ROUND HOLE, RMJ MINIATURE 

40 101443938  3 MINIATURE CONNECTOR, TYPE J MALE, SMPW-J-M 

41 100155318 789.01325 2 Monitor ext Cable DB9(F)x DB9(F)x 6ft 

42 101783537  1 Null Modem Cable DB9 Fem x DB9 Fem 6ft long 

43 203723  14 TERMINAL FEMALE CRIMP 14-20 AWG 

44 100032008 70.76197 16 TERMINAL, FEMALE, SLIP ON, FULLY INSULATED, FOR #10-12 GA WIRE, 
XS09788, HOLLINGSWORTH 

45 101713992  10 HI-TEMP WIRE, 1200F, 12 AWG 

46 365255  8 TERMINAL RING 10-12 AWG 10 HI TEMP HIGH TEMPERATURE RING TERMINAL 
NON-INSULATED 10 STUD SIZE 900 DEGREES F MAX 

47 100022082 70.10506 8 COVER, TERMINAL, CERAMIC, FOR MICA BAND HEATER B6A1JP4 

48 101784683  200 22 AWG stranded (7x30) TC conductors, S-R PVC insulation, overall Beldfoil® 
(100% coverage) + TC 
braid shield (65% coverage), PVC jacket. 

49 206242  240 WIRE 22 AWG TEFLON STRANDED BLUE 

50 208547  20 WIRE 22AWG TEFLON STRANDED BLACK 

51 208548  20 WIRE 22 AWG TEFLON STRANDED RED 

52 208549  20 WIRE 22 AWG TEFLON STRANDED WHITE 

53 100032006 70.76195 2 TERMINAL, FEMALE, SLIP ON, FULLY INSULATED, FOR 18-22 GA WIRE, 
XS09770S, HOLLINGSWORTH 

54 208485  3 WIRE THERMOCOUPLE DUPLEX TYPE 

55 100029508 70.53835 2 TERMINAL, CRIMP, 12-10 GA, #10 STUD, RING TYPE, INSULATION CRIMP 
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Find # Name Drawing Quantity Description 

56 100032007 70.76196 7 TERMINAL, FEMALE, SLIP ON, FULLY INSULATED, FOR #18-22 GA WIRE, 
XS09778, HOLLINGSWORTH 

57 349301  8 TERMINAL FEMALE Q.C,.25X.032 12-10GA THOMAS & BETTS TNF10-250FD 
NYLON FULLY INSULATED FEMALE DISCONNECT WIRE RANG 12/10 AWG TAB 
SIZE .250 X .032 25 PER PACKAGE 

58 203857  13 FERRULE INSUL 18 AWG WIRE 

59 203858  6 FERRULE INSUL 12 AWG WIRE 

60 204299  7 TERMINAL FEMALE Q.C .25X.032 1 

61 208457  2 BUTT SPLICE 2RA-18 

62 204288  2 DISCONNECT FEMALE .110 TAB 22- 

702 101262200  8 SCREW, THREADED, BUTTON HEAD SCS (US) - NO. 6 -32 UNC x 0.25 - 18-8 SS 

703 101267867  4 WASHER, FLAT (US) - NO. 6 SAE - 18-8 SS 

704 101262244  7 SCREW, THREADED, BUTTON HEAD SCS (US) - NO. 8 -32 UNC x 0.25 - 18-8 SS 

705 101262274  2 SCREW, THREADED, BUTTON HEAD SCS (US) - NO. 10 -32 UNF x 0.75 - 18-8 SS 

706 101262218  4 SCREW, THREADED, BUTTON HEAD SCS (US) - NO. 6 -32 UNC x 1.75 - 18-8 SS 

707 101262266  9 SCREW, THREADED, BUTTON HEAD SCS (US) - NO. 10 -32 UNF x 0.25 - 18-8 SS 

708 101267873  2 WASHER, FLAT (US) - NO. 10 USS - 18-8 SS 

709 101262156  8 SCREW, THREADED, BUTTON HEAD SCS (US) - NO. 4 -40 UNC x 0.25 - 18-8 SS 

710 101256658  8 NUT, HEX MACHINE SCREW (US) - NO. 4 -40 - GRADE 8 ZINC-PLATED STL 
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10.3. Mechanical Assembly 101595348 
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# Name Drawing / 

Rev Quantity Description 

  101595348 101595348   MECHANICAL ASSEMBLY, MACS II, FANN 

1 101586871 101586871 1 FRAME, MACS II 

2 101723010 101723010 1 TURN TABLE ASSEMBLY, MECHANICAL ASSEMBLY, MACS II 

3 101723011 101723011 1 TOP PLATE AND PRESSURE CELL BODY, MECHANICAL ASSEMBLY, MACS II 

4 101723012 101723012 1 FRAME DRAWER, MECHANICAL ASSEMBLY, MACS II 

5 101636768 101636768 1 SGS TEST CUP ASSY, MACS II 

6 101667558 101667558 1 THERMOCOUPLE, J TYPE, MACS II, TOP, 30000 PSI RATED, 56 IN LEADS 

7 101595801   2 BEARING, PILLOW BLOCK, 3/4 IN SHAFT SIZE 

8 101595822   2 SHAFT, COLLAR, D SHAPE, .75 IN ID. 

9 101595624   1 SHAFT, LINEAR PRECISION, .75 DIA, 16 IN LENGTH 

10 101266066   4 SCREW, THREADED, CAP, SOC HEAD (US) - 0.375 DIA -16 UNC x 4.50 - 18-8 
SS 

11 101267885   8 WASHER, FLAT (US) - 0.375 DIA SAE - 18-8 SS 

12 101676759   4 NUT, ELASTIC STOP, 3/8-16 NC, STAINLESS STEEL 

13 101675112   1 
ELECTRO-PNEUMATIC REGULATOR, 0.9 MPA, POWER VOLTAGE 24 VDC, INPUT 
SIGNAL 0-5 VDC, ANALOG OUTPUT 1-5 VDC, 1/4 PORT, PRESSURE DISPLAY 
UNIT PSI 
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14 100032885 70.80372 1 MUFFLER, EXHAUST, PNEUMATIC, 1/4, MOSIER EM-2 

15 100023811   6 CONNECTOR, PLASTIC TUBING, 90 DEG, 1/4 TUBE X 1/4 MPT, MILLER 
INSTANT TUBE, LEGRIS, 31095614 

16 101485082   2 VALVE, SOLENOID, 2 PORT, NC, 1/4 FEMALE NPT, 24V 

17 101265670   6 SCREW, THREADED, CAP, SOC HEAD (US) - 0.25 DIA -20 UNC x 0.50 - 18-8 
SS 

18 101267975   4 WASHER, LOCK, REGULAR SPRING (US) - NO. 8 - 18-8 SS 

19 101263938   4 SCREW, THREADED, LOW HEAD SCS (US) - NO. 8 -32 UNC x 0.375 - 18-8 SS 

20 101660656   2 HOSE, LOW PRESSURE METAL FLEXIBLE, 1/4 IN SS SWAGELOK TUBE AND 1/4 
IN SS MALE NPT END, 36 IN LENGTH 

21 101673153   120 1/4 TUBING, POLYURETHANE, 20 METER ROLL, BLUE 

22 101485964   1 TUBING, 3/8 IN O.D. POLYURETHANE, BLUE, TIUB11BU-20 

23 101443949   1 TUBING, STAINLESS STEEL, 1/8 OD X 0.020 ID, 60,000 PSI, 60-9H2, HIGH 
PRESSURE EQUIPMENT 

24 101443950   2 GLAND, 1/8 IN HP MALE, 60K PSI 

25 101443951   2 COLLAR, 1/8 IN, 60K PSI 

26 205555   96 TUBING 1/4 OD X .083 ID 304 ST 

27 100001771 70.24702 8 GLAND, AUTOCLAVE, ANGLE 40, 60000 POUNDS PER SQ IN, FOR 1/4 TUBE, 
F250C FEMALE THREAD 

28 100001646 70.16576 8 COLLAR, AUTOCLAVE, ACL40, 1/4 TUBE, 60000 PSI, STAINLESS STEEL 
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29 207377   216 TUBING SOFT COPPER 1/4 X .032 

30 120147184   1 ELBOW MALE SS-400-2-4 

31 101671856 101671856 1 THEROMCOUPLE, TYPE J, UNGROUNDED, 1.125 30000 PSI, MALE HP PORT 

32 101671154   1 TEE, 1/4 HP, 600000 PSI RATING WITH SPECIAL MOUNTING HOLES 

33 101392264   1 60K MALE TO MALE 1/4 HIGH PRESSURE CONNECTOR HIP 60-21HM4HM4 

34 100022028 70.10235 1 
TRANSDUCER, PRESSURE, 30000 PSI, 4-20 MA, 0.5% ACCURACY, F-250C 
AUTOCLAVE PRESSURE PORT, 2 WIRE ELECTRICAL CONNECTION WITH 1/2-14 
CONDUIT FITTING, ADJ ZERO AND SPAN POTS 

35 101632138   1 NIPPLE, HIP 60-HM4-6, 316 STAINLESS STEEL, 6 IN LONG, 60K PSI, 1/4 IN OD 
TUBE CONNECTIONS 

36 101266018   4 SCREW, THREADED, CAP, SOC HEAD (US) - 0.375 DIA -16 UNC x 0.50 - 18-8 
SS 

37 101443961   1 PNEUMATIC CYLINDER, 1.5 INCH BORE, 8 INCH STROKE, REAR PIVOT, PIVOT 
BUSHING, 

38 101443962   1 PNEUMATIC CYLINDER, 1.5 INCH BORE, 10.25 INCH STROKE, REAR PIVOT, 
PIVOT BUSHING, 

39 101675071   2 PIVOT BRACKET, 3/8 INCH PIN, 5/8 INCH GAP, STAINLESS STEEL 
FOR BIMBA CYL CM-17_-DPWY 

40 101675084   4 PNEUMATIC SPEED CONTROLLER, ELBOW, 1/4 INCH TUBING, 1/8 MNPT 

41 101762949   1 COILED SPRING PIN, 1/4 INCH DIA X 2.5 INCH LENGTH, STAINLESS STEEL 

42 101536645   1 ADAPTER 1/4 HIGH PRESS TUBE X 1/8 NPT (FEM) 
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43 101443938   2 MINIATURE CONNECTOR, TYPE J MALE, SMPW-J-M 

44 208404   1 CONNECTOR 2 PRONG TYPE J THERM 

45 101443937   1 PANEL THERMOCOUPLE JACK, ROUND HOLE, RMJ MINIATURE 

46 101775783   2 PISTON ROD CLEVIS (17-) 

47 101779959   4 POSITION SENSOR, BIMBA HSKX-17 

48 100072379 800.61514 1 ELBOW, FITTING, FEMALE, AUTOCLAVE, CL4400, F250C 

49 100016383 22.2003 1 ELBOW, 90 DEG, STREET, 1/4, BRASS 

50 208447   72 CABLE CONTROL SINGLE PAIR 22 A 

51 101645179   2 Locknut 1/4-20 SS 

52 101791035 101791035 1 MOUNT PLATE, ELECTRO-PNEUMATIC REGULATOR, MACS II 
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10.4. Top Plate and Pressure Cell Body 101723011 
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  101723011 101723011  TOP PLATE AND PRESSURE CELL BODY, MECHANICAL ASSEMBLY, MACS II 

1 101592165 101592165 1 TOP SHELF, MACS II 

2 101595614 101595614 4 STANDOFF, LID, MACS II 

3 101673132 101673132 1 GUARD, BELT COVER, MACS II 

4 101443964 101443964 1 BRACKET, GAUGE, EMERGENCY STOP, MACS II 

6 101592341 101592341 1 MOUNT, HIGH PRESSURE PUMP, MACS II 

7 101586876 101586876 1 ANGLE MOUNT, MOTOR AND TORQUE MEASUREMENT, MACS II 

8 101752937 101752937 1 KIT, KISTLER TORQUE SENSOR, MACS II 

9 101443921 101443921 1 BRACKET, TOP THERMOCOUPLE, MACS II 

10 101570647 101570647 1 SET, PRESSURE VESSEL, MACS II, FANN 

11 101636934 101636934 1 ADAPTER, SLURRY CUP RISER, MACS II 

12 101654535 101654535 3 COOLING BAND, MACS II 

13 101664360  3 HEATER BAND, 6 IN ID X 1 IN ID WIDE 220V 1250 WATTS, TYPE J 
THERMOCOUPLE WITH 36 IN LEAD WIRE 

14 101539543  1 GAUGE, PANEL MOUNT, 0-35K, SS MFG: McDANIEL MFG P/N: G35KU-1/4HPF-G 

15 101594774 101594774 1 BACKUP RING, PRESSURE VESSEL, MACS II 

16 101710014  1 O-RING, ULTRA PARAFLUOR, ID 2.984, COLOR WHITE, SIZE 2-234, 
DUROMETER 75 

17 101723009 101723009 1 MAG COUPLING, MACS II MAG DRIVE TO PADDLE AND SAMPLE CUP 

18 390009  1 PUMP, LIQUID, AIR OPERATED, 1:440 RATIO  
MAXIMATOR MAXPRO PP189-2 

19 101443954  1 MAGNEDRIVE, HIGH PRESSURE, 33,000 PSI 

20 101705761 101705761 1 TORQUE CALIBRATION STAND, MACS II 
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21 101710024 101710024 1 TORQUE CALIBRATION RING, MACS II 

22 101596797  1 TIMING BELT, 240XL, 120 TEETH, 3/8 WIDTH, 0.20 PITCH 

23 101727314  1 SWITCH, Emergency-stop non illuminated, ribbon cable, twist release, 32mm 
diameter for 22.5mm mounting, foolproof to EN 60947-5-5, EN 418, 250V, 3 
Amp 

24 101443933  1 SENSOR, U-SHAPED, 30MM SLOT WIDTH, VISIBLE RED BEAM 

25 101595569  1 MOTOR, STEPPER, ENCODER, NEMA 23, 170 VDC WINDING, DOUBLE SHAFT 

26 101595461  1 GEARHEAD, 5:1, NEMA 23, FLANGE FACE 

33 207377  1 TUBING SOFT COPPER 1/4 X .032 

34 120149512  4 ELBOW SS-400-9 

35 347021  1 ADAPTER, UNION, 1/4 TUBE 

36 205555  1 TUBING 1/4 OD X .083 ID 304 ST 

37 100001771 70.24702 8 GLAND, AUTOCLAVE, ANGLE 40, 60000 POUNDS PER SQ IN, FOR 1/4 TUBE, 
F250C FEMALE THREAD 

38 100001646 70.16576 8 COLLAR, AUTOCLAVE, ACL40, 1/4 TUBE, 60000 PSI, STAINLESS STEEL 

39 100034542 70.88705 1 NIPPLE - 2.75 IN LONG - 1/4 AE HIGH PRESSURE - 60000 PSI - F250C 
CONNECTION 

40 100029698 70.57414 1 TUBING, STAINLESS STEEL, 1/8 OD X 1/16 ID, 15-151, AUTOCLAVE 

41 101443952  2 SS SWAGELOK TUBE FITTING, MALE ELBOW, 1/8 IN. TUBE OD X 1/8 IN. MALE 
NPT 

42 101443953  2 SS SWAGELOK TUBE FITTING, BULKHEAD FEMALE CONNECTOR, 1/8 IN. TUBE 
OD X 1/8 IN. FEMALE NPT 

43 101392263  1 60K BULKHEAD FOR 1/4 F HIGH PRESSURE X 1/4 F HIGH PRESSURE HIP 60-
21HF4-B 

44 101452502  1 ADAPTER, ELBOW, BRASS, 3/8 MNPT X 1/4 TUBE 

45 101463369  1 ADAPTER, STRAIGHT, 1/4 MALE NPT TO 1/4 INSTANT TUBE 
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46 100033092 70.81424 1 CROSS, AUTOCLAVE ENGINEERS, CX4444-PM, 60 KPSI @RT, WITH F250C 
FEMALE HIGH PRESSURE EQUIPMENT CO: 60-24HF4-SP1 

47 101255666  4 SCREW, THREADED, CAP, SOCKET HEAD (METRIC) - M4 x 12 - 18-8 SS 

48 101255802  4 SCREW, THREADED, CAP, SOCKET HEAD (METRIC) - M4 x 20 - 18-8 SS 

53 101265328  6 SCREW, THREADED, CAP, SOC HEAD (US) - NO. 8 -32 UNC x 0.75 - 18-8 SS 

54 101631188  2 NUT, JAM, ELASTIC INSERT, 8-32 NC, STAINLESS STEEL 

55 101265667  2 SCREW, THREADED, CAP, SOC HEAD (US) - 0.25 DIA -20 UNC x 0.375 - 18-8 
SS 

56 101266303  4 SCREW, THREADED, CAP, SOC HEAD (US) - 0.50 DIA -20 UNF x 2 - 18-8 SS 

57 101265406  5 SCREW, THREADED, CAP, SOC HEAD (US) - NO. 10 -32 UNF x 0.375 - 18-8 SS 

61 101266036  5 SCREW, THREADED, CAP, SOC HEAD (US) - 0.375 DIA -16 UNC x 1.50 - 18-8 
SS 

62 101705712  2 ADAPTER, STRAIGHT, 1/8 MALE NPT TO 1/4 INSTANT TUBE 

63 207783  4 GROMMET RUBBER 1/4in. ID X 3/8in. 

64 101443948 101443948 1 BACKUP RING, MAG DRIVE, MACS II 

65 101710015  1 O-RING, ULTRA PARAFLUOR, ID .739, COLOR WHITE, SIZE 2-018, DUROMETER 
75 

66 100028829 70.44830 4 SCREW, SET, #10-32 NF X 3/8, CUP PORT, HEX SOCKET, STAINLESS STEEL 

902 101751741 101751741 1 KIT, HONEYWELL TORQUE SENSOR, MACS II 
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10.5.  Turn Table Assembly 101723010 

 



 MACS II User Manual  
 

101796668 Revision E  136 

Find # Name Drawing # Quantity Description 

  101723010 101723010  TURN TABLE ASSEMBLY, MECHANICAL ASSEMBLY, MACS II 

1 101591604 101591604 1 MOUNT, ROTATION PLATE, MACS II 

2 101643875 101643875 2 MOUNT, CUP RISER, MACS II 

3 101485177  1 VALVE, 3 PORT SOLENOID, BODY PORTED, 1/4 INSTANT TUBE FITING (A), 1/4 
FNPT (P), 1/8 FNPT (R) 

4 101542810  2 CONNECTOR, L PLUG WIRE, FOR SMC VALVE VQZ322-5LO-N7T 

5 101485082  1 VALVE, SOLENOID, 2 PORT, NC, 1/4 FEMALE NPT, 24V 

6 100047760 130.11749 1 VALVE, 60-11HF4, HIGH PRESSURE PRODUCTS 

7 100072640 800.86480 1 SAFETY HEAD ASSEMBLY, TEE, 1/4 50000 PSI RUPTURE DISC, HIGH 
PRESSURE EQUIPMENT, CO 60-63HF4 

8 101085670 93F1051 1 ELB,90 04T-06 MP SK SS-400-2-6 

9 101388195  2 ADAPTER, HIGH PRESSURE FITTING, 30K FEM-1/4 NPT X MALE 1/4 HP (HM4) 
HIP 30-21NFBHM4 

10 100022114 70.10803 1 TEE, MALE BRANCH, 1/4 IN SWAGELOK X 1/4 IN SWAGELOK X 1/4 IN NPT PIN, 
STAINLESS STEEL 

11 101733497  1 VALVE, AIR OPERATED, 30000 PSI, DUAL ACTING, WITH 209276 PACKING SET 

12 101392263  1 60K BULKHEAD FOR 1/4 F HIGH PRESSURE X 1/4 F HIGH PRESSURE HIP 60-
21HF4-B 

13 101463369  3 ADAPTER, STRAIGHT, 1/4 MALE NPT TO 1/4 INSTANT TUBE 

14 101733496  1 VALVE, 3 PORT SOLENOID, BODY PORTED, 1/4 INSTANT TUBE (A), 1/4 FNPT 
(P), 1/8 FNPT (R), N.C 

15 101485630  2 SILENCER, NAN(BC SINTERED), GENERAL PURPOSE, NOISE REDUCTION: 
16db, 1/8 MALE NPT 

16 101539546  2 ADAPTER, STRAIGHT, 1/4 MALE NPT, 3/8 TUBE 

17 101266018  4 SCREW, THREADED, CAP, SOC HEAD (US) - 0.375 DIA -16 UNC x 0.50 - 18-8 
SS 
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18 100034542 70.88705 2 NIPPLE - 2.75 IN LONG - 1/4 AE HIGH PRESSURE - 60000 PSI - F250C 
CONNECTION 

19 100001771 70.24702 2 GLAND, AUTOCLAVE, ANGLE 40, 60000 POUNDS PER SQ IN, FOR 1/4 TUBE, 
F250C FEMALE THREAD 

20 100001646 70.16576 2 COLLAR, AUTOCLAVE, ACL40, 1/4 TUBE, 60000 PSI, STAINLESS STEEL 

21 101265322  2 SCREW, THREADED, CAP, SOC HEAD (US) - NO. 8 -32 UNC x 0.50 - 18-8 SS 

22 101265337  2 SCREW, THREADED, CAP, SOC HEAD (US) - NO. 8 -32 UNC x 1.25 - 18-8 SS 

23 101264821  2 SCREW, THREADED, CAP, SOC HEAD (US) - NO. 4 -40 UNC x 1.75 - 18-8 SS 

24 101265427  2 SCREW, THREADED, CAP, SOC HEAD (US) - NO. 10 -32 UNF x 1.50 - 18-8 SS 

25 101673153  1 1/4 TUBING, POLYURETHANE, 20 METER ROLL, BLUE 

26 208977  24 TUBING 1/4 OD X .035 WALL 304S 

27 101464507  1 SWAGELOK STAINLESS MALE RUN TEE FOR 1/4 IN OD TUBE WITH 1/4 IN OD 
MALE NPT 

28 101542809  1 RUPTURE DISC, BURST PRESSURE 35000 PSI @ 72 F, 1/4 ANGLED SEAT 

29 120147184  1 ELBOW MALE SS-400-2-4 

30 100033128 70.81602 1 RAIL, MOUNTING, 35MM, X 1 METER, DIN,46277, SYMMETRICAL 

31 101262270  2 SCREW, THREADED, BUTTON HEAD SCS (US) - NO. 10 -32 UNF x 0.50 - 18-8 
SS 

32 101391619  2 CLAMP, END, UNIVERSAL, FOR 35 MM X 7.5 MM MOUNTING RAIL, E/NS 35 N 

33 101483688  14 Feed-through terminal blocks with spring-cage connection, cross section: 0.2 - 
2.5 mm, width: 5.2 mm, color: gray 

34 101462159  1 COVER, 2.2MM X 48.5 MM PHOENIX CONTACT 3030417 

35 101483689  5 Plug-in bridge for cross-connections in the terminal center, 2-pos., color: Red 

36 120170870  1 HI PRES 1/8`` FEM TO 1/4`` MALE 
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10.6. Frame Drawer, Mechanical Assembly 101723012  
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  101723012 101723012  FRAME DRAWER, MECHANICAL ASSEMBLY, MACS II 

1 101586871 101586871 1 FRAME, MACS II 

2 101569355  1 CLYLINDER, COMPACT GUIDE, 100MM BORE, 100MM STROKE 

3 101586874 101586874 1 ADAPTER, LINEAR TO ROTATIONAL, MACS II 

4 101595347  1 ROTARY ACTUATOR, RACK & PINION, 90 DEG, SINGLE SHAFT 

5 101775204  3 VALVE, SOLENOID, DIRECT OPERATED 3 PORT, COMMON, 1/4 FNPT, 24 VDC , 
3mm ORIFICE, BRACKET, DIN TERMINAL WITH LIGHT 

6 101539542  1 FILTER, 17-4PH, 30000 PSI RATED, 1/4 HP PORTS 

7 101485628  1 FILTER, 3 PORT 1/4 NPT, 10 MICRON, GENIEFILTERS AVENGER SERIES 91 

8 101485473  1 WATER SEPARATOR, AMG, 1/4 NPT PORTS, 3/8 INSTANT TUBE, WITH AUTO 
DRAIN, BRACKET 

9 101485137  1 FILTER, REGULATOR, MIST SEPARATOR, 1/4 FEMALE NPT, 3/8 INSTANT TUBE 
AUTO DRAIN 

10 101516393  1 VALVE, BACK PRESSURE REGULATOR, 30,000 PSI, 1/4 HIGH PRESSURE HYDR. 
PORTS, TESCOM 

11 208603  1 ADAPTER 1/4 X 1/8 NPT SPECIAL TAPER STAINLESS STEEL WILCO: 1/4 X 1/8 
HN SPECIAL TAPER ON 1/4 ONLY 10/22/2002 

12 101485323  1 ELECTRONIC PRESSURE CONTROLLER, PID, 1/8 NPT INLET PORT, 1/4 NPT 
CONTROLLED OUTLET PORT, TESCOM ER3000SI-1 

13 101645850  1 MANIFOLD, 6 PORT, 1/4 TUBE, SMC 
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14 101712396  4 SOLENOID VALVE, 5 PORT, 3 POSITION CENTER CLOSED, FOR MANIFOLD, 24V 
DC 

15 101710635  2 COVER PLATE, FOR VVQZ200 MANIFOLD 

16 101485667  2 SILENCER, NAN, GENERAL PURPOSE, NOISE REDUCTION: 35db, 1/4 MALE NPT 

17 100126559  1 REGULATOR, NPT 1/4 INCH, 15CFM, GRAINGER PART 4ZM08 

18 208602  1 GAUGE 160 PSI 1.5in DIAL 1/8 BOTTOM CONN 

19 101485740  2 NIPPLE, 1/4 MALE NPT ALL THREAD, 7/8 LENGTH, SS 

20 206626  3 PLUG PIPE 1/4 NPT SOCKET HEAD STAINLESS 

21 100023811  7 CONNECTOR, PLASTIC TUBING, 90 DEG, 1/4 TUBE X 1/4 MPT, MILLER 
INSTANT TUBE, LEGRIS, 31095614 

22 100033128 70.81602 1 RAIL, MOUNTING, 35MM, X 1 METER, DIN,46277, SYMMETRICAL 

23 101391619  2 CLAMP, END, UNIVERSAL, FOR 35 MM X 7.5 MM MOUNTING RAIL, E/NS 35 N 

24 101483688  64 Feed-through terminal blocks with spring-cage connection, cross section: 0.2 - 
2.5 mm, width: 5.2 mm, color: gray 

25 101634351  4 SPRING CAGE GROUND TERMINAL BLOCK, AWG 24 TO 14, YELLOW GREEN 

26 101462159  1 COVER, 2.2MM X 48.5 MM PHOENIX CONTACT 3030417 

27 101644288  4 ADAPTER, FLOW CONTROL, RC 3/8 TO 1/4 TUBE 

28 101452507  8 BULKHEAD, PANEL MOUNT, BRASS, 1/4 TUBE 

29 101304414  1 CONNECTOR, BULKHEAD, FEMALE, STAINLESS STEEL, 1/4-INCH O.D. - 1/8-
INCH FNPT 

30 208607  1 STREET ELL 1/4 SS-4-SE SWAGELOK 4-4-SE PARKER 
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31 120170870  1 HI PRES 1/8`` FEM TO 1/4`` MALE 

32 100068597 685.40729 1 UNION, BULKHEAD, 1/4 IN OD TUBE X 1/4 IN OD TUBE 

33 101539545  1 ADAPTER, ELBOW, BRANCH, 1/4 MNPT, 2X 3/8 TUBE, SMC KQ2Z11-35S 

34 101463367  1 ADAPTER, TRIPLE ELBOW, 1/4 MALE NPT TO 3X 1/4 INSTANT TUBE 

36 100022111 70.10799 2 CONNECTOR, MALE, STRAIGHT, 1/4 IN SWAGELOC X 1/4 IN NPT PIN, 
STAINLESS STEEL 

37 101463369  2 ADAPTER, STRAIGHT, 1/4 MALE NPT TO 1/4 INSTANT TUBE 

38 101543078  1 ADAPTER, ELBOW, 3/8 TUBE TO 1/4 MNPT 

39 101388195  1 ADAPTER, HIGH PRESSURE FITTING, 30K FEM-1/4 NPT X MALE 1/4 HP (HM4) 
HIP 30-21NFBHM4 

40 101485630  1 SILENCER, NAN(BC SINTERED), GENERAL PURPOSE, NOISE REDUCTION: 
16db, 1/8 MALE NPT 

41 101543075  1 ADAPTER, ELBOW, 3/8 TUBE TO 1/8 MNPT 

42 100001771 70.24702 2 GLAND, AUTOCLAVE, ANGLE 40, 60000 POUNDS PER SQ IN, FOR 1/4 TUBE, 
F250C FEMALE THREAD 

43 100001646 70.16576 2 COLLAR, AUTOCLAVE, ACL40, 1/4 TUBE, 60000 PSI, STAINLESS STEEL 

44 101256016  4 SCREW, THREADED, CAP, SOCKET HEAD (METRIC) - M12 x 25 - 18-8 SS 

45 101602091  8 WASHER, LOCK, M12, SPRING, 18-8 STAINLESS STEEL 

46 101674525  4 METRIC 18-8 SS HEX HEAD CAP SCREW M12, 25MM LENGTH, 1.75MM PITCH, 
FULLY THREADED 

47 101672614  4 Metric 18-8 SS Socket Head Cap Screw M14 Thread, 35mm Length, 2mm Pitch 
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Find # Name Drawing # Quantity Description 

48 100123752  4 SCREW, MACHINE, 10-32 X 3/8, BUTTON, ALLEN, SS1(UNBRAKO) 

49 101265343  4 SCREW, THREADED, CAP, SOC HEAD (US) - NO. 8 -32 UNC x 1.75 - 18-8 SS 

50 101696683  4 SCREW, 3/8-24 X 1.5, SS, SOCKET HEAD CAP 

51 101265322  12 SCREW, THREADED, CAP, SOC HEAD (US) - NO. 8 -32 UNC x 0.50 - 18-8 SS 

52 101265670  4 SCREW, THREADED, CAP, SOC HEAD (US) - 0.25 DIA -20 UNC x 0.50 - 18-8 
SS 

53 100035270 70.93472 2 NUT, ELASTIC STOP, 1/4-20 NC, LIGHT HEX, STAINLESS STEEL, ESNA #79NE-
040 

54 100112806  2 SCREW, SOCKET HEAD CAP, #10-32 UNF X 3/8, STAINLESS STEEL, 
HEXAGONAL SOCKET 

55 101265889  2 SCREW, THREADED, CAP, SOC HEAD (US) - 0.3125 DIA -18 UNC x 4 - 18-8 SS 

56 207377  1 TUBING SOFT COPPER 1/4 X .032 

57 101485749  6 VALVE, CHECK, 1/4 INSTANT PUSH TUBE PORTS, AKH07-00 

58 101485744  1 ADAPTER, TRIPPLE UNIVERSAL MALE ELBOW, 1/4 MALE NPT TO 3X 3/8 
INSTANT PUSH TUBE, KQ2VT11-35S 

59 101485750  1 ADAPTER, ELBOW, 1/4 FEMALE NPT TO 1/4 INSTANT PUSH TUBE, KQ2LF07-35 

60 100020617 70.01468 1 TEE, FEMALE BRANCH, SWAGELOC, 1/4 TUBE, 1/4 FNPT, STAINLESS STEEL 

61 101696554  1 ADAPTER, CROSS, 1/4 TUBING SMC 

62 101673153  1 1/4 TUBING, POLYURETHANE, 20 METER ROLL, BLUE 

63 205555  1 TUBING 1/4 OD X .083 ID 304 ST 

64 101708447  1 TEE, INST TUBE, DIFFERENT DIAMETER, 2X 1/4 TO 1X 3/8 
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Find # Name Drawing # Quantity Description 

65 101708752  1 CROSS, 3/8 TUBE 

66 101485964  1 TUBING, 3/8 IN O.D. POLYURETHANE, BLUE, TIUB11BU-20 

67 101645666  1 ADJUSTABLE STOP, STANDARD, CARR LANE 

68 101645668  1 BLOCK, SIDEWAYS MOUNTING, CARR LANE 

69 101266411  2 SCREW, THREADED, CAP, SOC HEAD (US) - 0.50 DIA -13 UNC x 4 - 18-8 SS 

70 101266378  1 SCREW, THREADED, CAP, SOC HEAD (US) - 0.50 DIA -13 UNC x 1 - 18-8 SS 

71 101543077  3 VALVE, CHECK, 3/8 TUBE 

72 101483689  25 Plug-in bridge for cross-connections in the terminal center, 2-pos., color: Red 

74 204056  1 BULKHEAD FEMALE 1/4T X 1/4FNPT 

75 101543076  1 TEE, 3/8 TUBE 

76 101486173  2 SCREW, CAP, SOCKET HEAD, 5/16-18 X 4, STAINLESS STEEL 

77 100029924 70.58962 4 WASHER, LOCK, 5/8, STEEL, PL, SPEC 70.59034 

78 101566781  4 FITTING, FEMALE CONNECTOR, BRASS, 1/4 IN OD TUBE X 1/4 IN NPT FEMALE, 
PUSH ASSEMBLY FOR SOFT TUBING (POLYETHYLENE, NYLON, SOFT METAL), 
PARKER PRESTOLOK 

79 208510  240 CABLE AUDIO 2 COND GEOPHONE 31 
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10.7. SGS Test Cup Assembly 101636768 
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Find # Name Drawing # Quantity Description 

  101636768 101636768  SGS TEST CUP ASSY, MACS II 

1 101837418 800.03006 1 SLURRY CUP ASSEMBLY, MACS 2 

2 101636441 101636441 1 PADDLE ASSEMBLY, SGS, MACS II 

3 101698207 101698207 1 CUP COUPLING, MACS II MAG DRIVE TO PADDLE AND SAMPLE CUP 

4 100001522 70.10643 1 RING, RETAINING, EXTERNAL, 0.25 SHAFT, STAINLESS STEEL 
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10.8.  Slurry Cup Assembly 101837418 
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Find # Name Drawing # Quantity Description 

  100072017 800.03006   SLURRY CUP ASSEMBLY, AUTO MINI MACS 

1 100007912 800.59772 1 PLUG, BASE, SLURRY CUP, MINIMACS 

2 101836939 101836939 1 GASKET, CUP PLUG, HIGH TEMPERATURE MACS 2 

3 100072323 800.59771 1 BASE, SLURRY CUP, MINMACS 

4 101836938 101836938 1 GASKET, CUP BASE, HIGH TEMPERATURE MACS 2 

5 100007920 800.64101 1 SLEEVE, SLURRY CUP, CONSISTOMETER, 30 KPSI 

6 100072315 800.59725 1 BAFFLE, BOTTOM, SLURRY CUP, WATER PRESSURIZED CONSISTOMETER 

7 100072316 800.59727 1 BAFFLE, TOP, SLURRY CUP, WATER PRESSURIZED CONSISTOMETER 

8 101837384  1 O-RING, 568-232, PERFLUORO WHITE 90 DURO 600F 

9 100072318 800.59729 1 CAP, TOP, NON ROTATING, SLURRY CUP, WATER PRESSURIZED CONSISTOMETER 

10 100072317 800.59728 1 STEM, VALVE, SLURRY CUP, WATER PRESSURIZED CONSISTOMETER 

11 100001522 70.10643 1 RING, RETAINING, EXTERNAL, 0.25 SHAFT, STAINLESS STEEL 

12 100072313 800.59723 1 RING, LOCK, EXTRA LONG, SLURRY CUP, MINI MACS CONSISTOMETER 
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10.9.  Paddle Assembly, SGS 101636441 
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Find # Name Drawing 
# 

Quantity Description 

  101636441 101636441   PADDLE ASSEMBLY, SGS, MACS 2 

1 101636267 101636267 1 SHAFT, MODIFIED, SLURRY CUP, MACS 2 

2 100007913 800.59774  1 BLADE, UPPER, SGS PADDLE, MINIMACS 

3 100021371 800.59774  1 PIN, ROLL, 1/16 X 1/2, STAINLESS STEEL 

4 100002427 800.59774 1 O-RING, TEFLON, 3/8 OD X 1/4 ID X 1/16 ROUND 568-010 

5 100007914 800.59774  1 BLADE, LOWER, SGS PADDLE, MINIMACS 

6 100001522 800.10643  1 RING, RETAINING, EXTERNAL 0.25 SHAFT,  SS 

7 101837396  1 O-RING, 568-107, PERFLUORO WHITE 90 DURO 600F 

8 100007910 800.59774  1 COUPLING, DRIVE, PADDLE, AUTO MINI MACS 

9 100040541 800.59774 1 CONTAINER, 4 1/2 X 4 1/2 X 10 1/2 ID, REGULAR SLOTTED CARTON 200, 
SINGLE WALL, C-FLUTE, GLUED, PRINTED, 1 COLOR, 2 PANELS, STYLE C, REV. 
3/30/90 
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10.10. Spares 1 Year MACS II Analyzer 101877938 
P/N Quantity Description 

101667558  1 

PREMIUM GRADE; TYPE JJ CALIBRATION T/C WITH SPECIAL LIMITS OF +/-
0.4%; 0.063 IN OD; SINGLE UNGROUNDED JUNCTION; 21 IN LONG; 316SS 
MATERIAL; LEAD WIRE: 20AWG TEFLON INSULATED LEAD WIRE; 68 IN 
LONG; MINIATURE PLUG (MP) 

101671856  1 THERMOCOUPLE, TYPE J, UNGROUNDED, 1.125 30000 PSI, MALE HP PORT  

101918773  1 
THERMOCOUPLE, SPRING ADJUSTABLE, UNGROUNDED TYPE J, PIG TALE 
USED WITH BAYONET ADAPTOR, 48 INCH LENGTH WITH SS WIRE BRAID   

101594774  8 BACKUP RING, PRESSURE VESSEL 
101710014  4 O-RING, ULTRA PAROFLUOR, ID 2.984,  SIZE 2-234, DUROMETER 75   
101710015  4 O-RING, ULTRA PAROFLUOR, ID .739,  SIZE 2-018, DUROMETER 75   
101596797  2 TIMING BELT, 240XL, 120 TEETH, 3/8 WIDTH, 0.20 PITCH   

101542809  1 
RUPTURE DISC, BURST PRESSURE 34500 PSI @ 72 F, 1/4 ANGLED SEAT, 316 
SS   

101636441  5 PADDLE ASSEMBLY, SGS 
70.10643   50 RING, RETAINING, EXTERNAL, 0.25 SHAFT, STAINLESS STEEL   
101836939  30 GASKET, CAP PLUG, HIGH TEMP  
101836938  10 GASKET, CUP BASE, HIGH TEMP   
101837384  4 O-RING,568-232, PERFLUORO,  90 DURO 600F   

101626358  1 
FILTER ELEMENT, HIGH PRESSURE, 25 MICRON, 304 WIRE MESH, 3B 
FILTER,VITON O-RING, USED WITH FILTER 101539542   

101629340  3 KIT, SOFT GOODS, 30,000 PSIG, TESCOM REGULATOR   
101629342  3 KIT, REPAIR, TESCOM 54-21N0T44A-095 REGULATOR, 30,000 PSIG   
101837396  4 O-RING 568-107 PERFLUORO,  90 DURO 600 F   
70.82789   50 O-RING, TEFLON, 3/8 OD X 1/4 ID X 1/16 ROUND 568-010   
102052994  5 WATER FILTER ELEMENT, 10 MICRON SS 
101673153  120 1/4 TUBING, POLYURETHANE, 20 METER ROLL 
101485964  10 TUBING, 3/8 IN O.D. POLYURETHANE, TIUB11BU-20   
101630287  4 KIT, 3 ORINGS FOR P8791-HP-40WEV ORING 212V, 138V, AND 138VP   
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10.11. Spares 2 Year MACS II Analyzer 101877945 
P/N Quantity Description 

101667558 

2 

PREMIUM GRADE; TYPE JJ CALIBRATION T/C WITH SPECIAL LIMITS OF +/-
0.4%; 0.063 IN OD; SINGLE UNGROUNDED JUNCTION; 21 IN LONG; 316SS 
MATERIAL; LEAD WIRE: 20AWG TEFLON INSULATED LEAD WIRE; 68 IN 
LONG; MINIATURE PLUG (MP) 

101671856  2 THERMOCOUPLE, TYPE J, UNGROUNDED, 1.125 30000 PSI, MALE HP PORT  

101918773  1 
THERMOCOUPLE, SPRING ADJUSTABLE, UNGROUNDED TYPE J, PIG TALE 
USED WITH BAYONET ADAPTOR, 48 INCH LENGTH WITH SS WIRE BRAID   

70.10235   1 
TRANSDUCER, PRESSURE, 30000 PSI, 4-20 MA, 0.5% ACCURACY, F-250C 
AUTOCLAVE PRESSURE PORT, ADJ ZERO AND SPAN POTS   

101594774  20 BACKUP RING, PRESSURE VESSEL   
101710014  10 O-RING, ULTRA PAROFLUOR, ID 2.984, SIZE 2-234, DUROMETER 75   
101710015  10 O-RING, ULTRA PAROFLUOR, ID .739,  SIZE 2-018, DUROMETER 75   
101596797  5 TIMING BELT, 240XL, 120 TEETH, 3/8 WIDTH, 0.20 PITCH   

101542809  2 
RUPTURE DISC, BURST PRESSURE 34500 PSI @ 72 F, 1/4 ANGLED SEAT, 
316 SS   

101636441  12 PADDLE ASSEMBLY, SGS   
70.10643   100 RING, RETAINING, EXTERNAL, 0.25 SHAFT, STAINLESS STEEL   
101836939  50 GASKET, CAP PLUG, HIGH TEMP  
101836938  15 GASKET, CUP BASE, HIGH TEMP   
101837384  10 O-RING,568-232, PERFLUORO,  90 DURO 600F   

101626358  4 
FILTER ELEMENT, HIGH PRESSURE, 25 MICRON, 304 WIRE MESH, 3B 
FILTER,VITON O-RING, USED WITH FILTER 101539542   

101629340  5 KIT, SOFT GOODS, 30,000 PSIG, TESCOM REGULATOR   
101629342  5 KIT, REPAIR, TESCOM 54-21N0T44A-095 REGULATOR, 30,000 PSIG   
101837396  10 O-RING 568-107 PERFLUORO,  90 DURO 600 F   
70.82789   100 O-RING, TEFLON, 3/8 OD X 1/4 ID X 1/16 ROUND 568-010   
102052994  10 WATER FILTER ELEMENT, 10 MICRON SS 
101673153  240 1/4 TUBING, POLYURETHANE, 20 METER ROLL   
101485964  20 TUBING, 3/8 IN O.D. POLYURETHANE, TIUB11BU-20   
101630287  10 KIT, 3 ORINGS FOR P8791-HP-40WEV ORING 212V, 138V, AND 138VP   
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Warranty and Return
 

 

Fann Instrument Company  
P.O. Box 4350 

LIMITED WARRANTY 
Fann warrants only title to the equipment, products and materials supplied and that 
the same are free from defects in workmanship and materials for one year from date 
of delivery. THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED OF 
MERCHANTABILITY, FITNESS OR OTHERWISE BEYOND THOSE STATED IN THE 
IMMEDIATELY PRECEDING SENTENCE. Fann's sole liability and Customer's exclusive 
remedy in any cause of action (whether in contract, tort, breach of warranty or 
otherwise) arising out of the sale, lease or use of any equipment, products or 
materials is expressly limited to the replacement of such on their return to Fann or, 
at Fann's' option, to the allowance to Customer of credit for the cost of such items. 
In no event shall Fann be liable for special, incidental, indirect, consequential or 
punitive damages. Notwithstanding any specification or description in its catalogs, 
literature or brochures of materials used in the manufacture of its products, Fann 
reserves the right to substitute other materials without notice. Fann does not 
warrant in any way equipment, products, and material not manufactured by Fann, 
and such will be sold only with the warranties, if any, that are given by the 
manufacturer thereof. Fann will only pass through to Customer the warranty granted 
to it by the manufacturer of such items. 

Out of warranty products will be repaired for a nominal charge. 

Please refer to the accompanying warranty statement enclosed with the product 

For your protection, items being returned must be carefully packed to prevent 
damage in shipment and insured against possible damage or loss. Fann will not be 
responsible for damage resulting from careless or insufficient packing. 

Before returning items for any reason, authorization must be obtained from Fann 
Instrument Company. When applying for authorization, please include information 
regarding the reason the items are to be returned. 
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Contact Fann Instrument Company 
  

Phone 1-281-871-4482 
1-800-347-0450 
 

Fax 1-281-871-4358 

Postal Address Fann Instrument Company 
P.O. Box 4350 
Houston, Texas, 77210 USA 
 

Shipping 
Address 

Fann Instrument Company 
14851 Milner Road, Gate 5 
Houston, Texas, 77032, USA  
 

Online www.fann.com 
fannmail@fann.com 
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